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About this topic collection

This PDF file has been created from the WebSphere Message Broker Version 6.1 (fix
pack 8 update, July 2010) information center topics. Always refer to the WebSphere
Message Broker online information center to access the most current information.
The information center is periodically updated on the document update site and
this PDF and others that you can download from that Web site might not contain
the most current information.

The topic content included in the PDF does not include the "Related Links"
sections provided in the online topics. Links within the topic content itself are
included, but are active only if they link to another topic in the same PDF
collection. Links to topics outside this topic collection are also shown, but result in
a "file not found "error message. Use the online information to navigate freely
between topics.

Feedback: do not provide feedback on this PDF. Refer to the online information to
ensure that you have access to the most current information, and use the Feedback
link that appears at the end of each topic to report any errors or suggestions for
improvement. Using the Feedback link provides precise information about the
location of your comment.

The content of these topics is created for viewing online; you might find that the
formatting and presentation of some figures, tables, examples, and so on are not
optimized for the printed page. Text highlighting might also have a different
appearance.

© Copyright IBM Corp. 2000, 2010 v

ftp://ftp.software.ibm.com/software/integration/wbibrokers/docs


vi Managing your Installation



Part 1. Installing

Installing . . . . . . . . . . . . . . . 3
Installation Guide. . . . . . . . . . . . . 3
Finding the latest information . . . . . . . . 4
Installing complementary products . . . . . . . 5

Installing IBM DB2 . . . . . . . . . . . 5
Installing Tivoli License Manager . . . . . . 5
Installing plug-ins using Eclipse Update Manager 6
Publishing in a Citrix XenApp environment . . . 6

Setting up a command environment . . . . . . 9
Command environment: Windows platforms . . 9
Command environment: Linux and UNIX
systems . . . . . . . . . . . . . . . 11

Applying service to runtime components . . . . 13
Downloading a fix pack . . . . . . . . . 14
Applying service on computers with multiple
installations . . . . . . . . . . . . . 15
Installing service on Windows . . . . . . . 15
Installing service on Linux and UNIX . . . . 19
Installing service on z/OS . . . . . . . . 22

Applying service to the Message Broker Toolkit . . 23
Changing the update repositories for Installation
Manager . . . . . . . . . . . . . . 25
Setting FTP and HTTP proxies for Installation
Manager . . . . . . . . . . . . . . 26

© Copyright IBM Corp. 2000, 2010 1



2 Managing your Installation



Installing

Installation information for WebSphere® Message Broker is provided in the
WebSphere Message Broker Installation Guide, which is supplied in hardcopy with
your product media.

The “Installation Guide” defines hardware and software requirements for
WebSphere Message Broker and its corequisite and prerequisite products. It
describes the tasks that you must complete to prepare for installation, to install
WebSphere Message Broker, and to verify the installation. When you have
completed installation, use this information center to create and configure your
components and the broker domain.

The software and hardware requirements are also provided within this information
center in the “Installation” on page 41 reference section. This section also includes
information about the support for 32-bit and 64-bit operating modes, and the
changes and additions in Version 6.1.

See “Finding the latest information” on page 4 for details about how to check that
you have access to the most recent information available.

If product fixes or updates are made available, refer to the following topics for
information about how to apply these changes:
v “Applying service to runtime components” on page 13
v “Applying service to the Message Broker Toolkit” on page 23

You do not have to apply service to the runtime components and the Message
Broker Toolkit at the same time; all Version 6.1 fix pack levels are compatible with
all other fix pack levels. However, if a fix pack delivers additional nodes (for
example, the PHPCompute node is included in Version 6.1.0.3), you must ensure
that the Message Broker Toolkit and the brokers to which you deploy the message
flows that include these nodes are at the same fix pack level, and that you have set
the correct function level of those brokers by using the -f flag on the
mqsichangebroker command.

To install complementary products including DB2®, see “Installing complementary
products” on page 5.

Installation Guide
Installation information for WebSphere Message Broker is provided in the
Installation Guide that is supplied in hardcopy with your product package.

The guide provides general preparation, planning, and security information for all
platforms. It also provides installation instructions for distributed systems, and
describes common problems and solutions and the names and locations of the
installation log files. The guide also covers verification programs on Linux® on x86
and Windows®.

If you are installing on z/OS®, the equivalent installation instructions are provided
in the Program Directory that is supplied in hardcopy with your product media.
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The Installation Guide does not cover configuration or customization tasks on any
operating system; it describes only how you install the product components onto
your computers. When you have completed installation on distributed systems,
you must initialize the local environment before you can create or configure
resources. This task is described in “Setting up a command environment” on page
9. Environment initialization is not required on z/OS. Refer to Configuring
WebSphere Message Broker for information about how to design and configure
your broker environment on all systems.

The Installation Guide is available in English and in translation as PDF files:
v On the Quick Start CD
v In the IBM® Publications Center

You can view, search, and print PDF files using Adobe® Reader. To download
Adobe Reader, visit the Adobe Systems Inc. Web site.

Finding the latest information
Access the latest information for WebSphere Message Broker.

The following information is provided:

Requirements Web site
For the latest details of hardware and software requirements on all
supported platforms, visit the WebSphere Message Broker Requirements
Web site.

readme.html
The product readme file is frequently updated and includes information
about last minute changes and known problems and workarounds. The file
is included on the product media and is installed when you install product
components. The latest version is always on the product readmes Web
page; always check to see that you have the latest copy.

Installation Guide
The Installation Guide is provided in hardcopy with your product. It is
also available on the IBM Publications Center Web site. See “Installation
Guide” on page 3 for instructions about how to access this site to view the
guide online or check whether a later edition of the guide is available.

Information center
This information center is installed with the Message Broker Toolkit, and
updates are typically included when you apply service to that component.

The information center is periodically updated independently of the code,
and you can install the latest level from within the toolkit. See 'Applying
service to the Message Broker Toolkit' in the information center for
instructions about installing code and documentation updates.

Support information
The WebSphere Message Broker support Web page is regularly updated
with the latest product support information. For example, if you are
migrating from an earlier version, look under the heading "Solve a
problem" for the document "Problems and solutions when migrating".
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Installing complementary products
WebSphere Message Broker works with several other products to provide
complementary services.

If you want to use these optional services in your WebSphere Message Broker
environment, refer to the following installation information:
v IBM DB2
v IBM Tivoli® License Manager
v Eclipse plug-ins from another vendor
v “Publishing in a Citrix XenApp environment” on page 6

Installing IBM DB2
IBM DB2 Enterprise Server is one of the supported databases for use with
WebSphere Message Broker.

Other editions of IBM DB2 that are stated to be suitable for production deployment
are also supported. For a full list of supported databases and versions, from IBM
and other vendors, see “Supported databases” on page 48.

On Windows only, the Derby database is embedded in the broker component. It is
suitable for verification and evaluation only, and is enabled when you install the
ODBC Drivers from the Launchpad as part of the WebSphere Message Broker
product installation. For production systems, you must install one of the supported
databases, for example, DB2 Enterprise Server. For information about how to
install ODBC Drivers as part of the WebSphere Message Broker installation, see the
“Installation Guide” on page 3.

For distributed systems, DB2 Enterprise Server Version 9.1 is supplied on DVD (for
Linux on x86 and Windows only) and on CD with WebSphere Message Broker.
DB2 can be installed either before or after you have installed WebSphere Message
Broker. To install DB2, see the install.html file in the /doc directory on the CD or
DVD. The supplied version is subject to restricted terms and conditions for use
with WebSphere Message Broker. Help is provided by the installation wizard
following license acceptance.

For z/OS systems, either DB2 Version 8.1 or DB2 Version 9.1 is required, but no
other databases are supported. You must install DB2 before you install WebSphere
Message Broker on z/OS systems.

Installing Tivoli License Manager
IBM Tivoli License Manager (ITLM) enables you to monitor the use of IBM (and
other) software products. WebSphere Message Broker includes support for ITLM
Version 2.1.

Use ITLM to perform the following software auditing functions:
v Monitor the licenses used by different machines.
v Help keep unnecessary licenses to a minimum.
v Guard against software license compliance problems.

Ensure that you choose the correct ITLM license for the WebSphere Message
Broker edition that you have purchased. See Operation modes.
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If you are using one or more of the WebSphere Adapters with WebSphere Message
Broker, you must activate ITLM to include those adapters, for example in
monitoring activities. If you require this support, follow the instructions in
Activating IBM Tivoli License Manager for WebSphere Adapters.

To find out more about using ITLM to monitor usage of WebSphere Message
Broker and other IBM products, or to purchase ITLM, see the IBM Tivoli License
Manager Web site.

For information about installing this product, see the IBM Tivoli License Manager
Information Center.

Installing plug-ins using Eclipse Update Manager
Use Eclipse Update Manager to install and update plug-ins provided by partners
and other software vendors.

Do not use the Eclipse Update Manager to update or install plug-ins that are
managed by IBM Installation Manager. Always use Installation Manager to work
with products that are installed with Installation Manager. For other products, use
Eclipse Update Manager, but follow the restrictions and guidance provided:
v Do not delete the platform.xml file to prompt Eclipse to regenerate the file. The

regenerated contents will be incomplete and therefore invalid.
v Always save a backup copy of your platform.xml file before you make any

changes to your configuration, for example by using Eclipse Update Manager to
install or update plug-ins that are provided by another software vendor.

v When you use Eclipse Update Manager (graphical interface or command line),
always specify the package group directory as the destination; never specify the
shared resource directory. The shared resource directory is managed by
Installation Manager and is reserved for its use.

v Do not use Eclipse Update Manager to search for updates for features that you
have installed using Installation Manager.

v Do not select Clean up all configuration errors in the Eclipse Update Manager
interface; this option might lose information that is maintained by Installation
Manager.

Publishing in a Citrix XenApp environment
Supply application location and user details to Citrix to publish a WebSphere
Message Broker command console or Message Broker Toolkit.

Read the Citrix documentation for general information about publishing
applications. Publishing does not involve any tasks within WebSphere Message
Broker; you complete the following tasks in the Citrix Presentation Server console.

“Publishing a WebSphere Message Broker command console”
“Publishing a Message Broker Toolkit” on page 7
“Publishing applications using the CMP API” on page 7

Publishing a WebSphere Message Broker command console

The following steps show how to set the Application Location and User
information to publish a WebSphere Message Broker command console.
1. Set the Application Type to Application.
2. Set the Command Line to the following value: This example assumes that you

have installed a 32-bit operating system.
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C:\WINDOWS\system32\cmd.exe /k title IBM WebSphere Message Brokers 6.1
&&"install_dir\MQSI\6.1\bin\mqsiprofile.cmd"

On Windows, you can install the WebSphere Message Broker runtime
environment in multiple locations. Each one can have a different level of
service (fix pack) applied and can support a certain set of brokers. Each
installation has its own command console executable. To publish command
consoles corresponding to different runtime environments, modify the path to
mqsiprofile.cmd appropriately.

3. Set the Working Directory to install_dir\MQSI\6.1.
4. Define the users who are authorized to use the WebSphere Message Broker

command console. This must be a subset of users or groups who are
authorized to use the command console locally, on the server.
Attention: Users who have access to the WebSphere Message Broker
command console through Citrix can use the console to run other commands
that are unrelated to the broker.

Publishing a Message Broker Toolkit

To publish a Message Broker Toolkit, set the Application Location and User
information as follows:
1. Set the Application Type to Application.
2. Set the Command Line to the package group directory for Message Broker

Toolkit that your system uses, for example:
E:\WMBT610\eclipse.exe

3. Set the Working Directory to the appropriate workspace, for example:
E:\workspace\wbmt61\workspace1

When the workbench is run from Citrix, a window inviting the user to select a
workspace is displayed. This is the same window that you see when you run
the workbench locally. At this stage you can specify a different workspace, for
which you have the necessary Windows read and write file permissions on the
server.

4. Define the users who are authorized to use the WebSphere Message Broker
command console. This must be a subset of users or groups who are
authorized to use the command console locally, on the server.

Publishing applications using the CMP API

You can publish a Java™ application that uses the CMP API programming
interface. The steps are similar to publishing a Message Broker Toolkit or
command console.

For example, to publish the CMP API Exerciser sample, publish this file:
install_dir\sample\ConfigManagerProxy\StartConfigManagerProxyExerciser.bat

Users and Citrix
Review the categories of user that might want to use with Citrix, and how to
configure for concurrent multi-users.

Categories of user

The following categories of user exist:

Application developers
These users do not need to run mqsi commands, but must be placed in an
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access control list (ACL) before they can use a broker. Put these users only
in the user list for publishing Message Broker Toolkit.

Administrators
If you use Citrix to publish the Message Broker Toolkit and the WebSphere
Message Broker command console, put all administrators in the users lists
for both applications. For information about the permissions that
administrators need, see Security requirements for administrative tasks.

You can create Windows groups that correspond to the application developer and
administrator categories, put the groups in the appropriate user lists, then allocate
users to the relevant Windows group. Alternatively, you can give appropriate
permissions directly to the user.

Make all users members of the Remote Desktop Users group, so that they can use
Terminal Server.

Attention: Users who have access to the WebSphere Message Broker command
console through Citrix can use the console to run other commands that
are unrelated to the broker.

Deployment and changes to running brokers are controlled by broker ACLs
defined by mqsi commands, rather than operating system groups. These ACLs are
platform-independent; for more information, see Security for runtime resources:
Access control lists.

For information about the rights of groups such as mqm, mqbrkrs, and
Administrators, see Security requirements for Windows platforms.

Concurrent multi-users

Allowing multiple concurrent users to access WebSphere Message Broker by Citrix
on a Windows server requires the same planning as allowing multiple concurrent
users to access the WebSphere Message Broker on a Linux or UNIX® server. For
example:
v All application developers should have their own execution group, so that they

can deploy message flows and start and stop execution groups without
conflicting with each other during development and testing. However, an
exection group might be administered by more than one administrator. In these
cases, administrators should coordinate their activities so that they do not
conflict with each other. For example, when one administrator is starting an
execution group, no one else should be trying to stop it.

v All users should have their own workspace. The Windows system administrator
should give each user the appropriate read and write permissions for the
directory that corresponds to their workspace.

v The Message Broker Toolkit user can create the default configuration from the
Samples Gallery; the product samples are deployed to the default configuration.
Because you can create only one default configuration, only one user should use
it at one time.

You can view samples information only when you use the information center that
is integrated with the Message Broker Toolkit or the online information center.
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Setting up a command environment
After you have installed the product on one of the distributed systems, you must
initialize the environment before you can use a runtime component or command.

Also complete this task if you have migrated to WebSphere Message Broker
Version 6.1 from a previous version. A profile is provided to help you set up the
environment.

If appropriate, you can extend the initialization performed by this profile; for
example, for broker or user databases, or for other products that you want to use
within the broker.

Ensure that you use this environment each time you run an administrative
command, or start a component; for example, a broker.

For information on setting up your command and runtime environment on a
Windows system, see “Command environment: Windows platforms”

For information on setting up your command and runtime environment on Linux
and UNIX systems, see “Command environment: Linux and UNIX systems” on
page 11

Command environment: Windows platforms
Set up the Windows environment to run WebSphere Message Broker commands.

On Windows platforms, the components run as services, therefore they do not
inherit the environment that is set for the command prompt from which you start
them. The components run the mqsiprofile command when they start, which
completes the environment initialization.

The mqsiprofile command is located in the directory install_dir\bin.

You must not change the location of the mqsiprofile command, or make user
modifications to the command, because it might be replaced if you install service,
or an update, to the product.

If you need to run your own settings, add one or more command files called
your_file_name.cmd to the directory work_path\common\profiles, where work_path
identifies the broker's working directory.

The default working directory is %ALLUSERSPROFILE%\Application Data\IBM\MQSI
where %ALLUSERSPROFILE% is the environment variable that defines the system
working directory. The default directory depends on the operating system:
v On Windows XP and Windows Server 2003: C:\Documents and Settings\All

Users\Application Data\IBM\MQSI

v On Windows Vista and Windows Server 2008: C:\ProgramData\IBM\MQSI

The actual value might be different on your computer.

If you are unsure of the broker's work path, enter the following command in a
command console:
echo %MQSI_WORKPATH%
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When mqsiprofile runs, it automatically calls any additional user-written scripts in
this directory.

A typical reason for adding scripts is “Running database setup scripts.”

When you have configured any additional setup, you can use one of the following
methods to initialize the runtime environment for components and commands:
1. If you have only one installation of the runtime product, open a command

console by clicking Start → IBM → WebSphere Message Brokers 6.1 →
Command Console. The mqsiprofile command initializes the environment and
invokes any additional scripts in the common\profiles directory.

2. If you have one or more installations of the runtime product, open a command
prompt window. Locate and run the mqsiprofile.cmd script in the directory in
which you installed the appropriate product. The mqsiprofile command
initializes the environment and invokes any additional scripts in the
common\profiles directory.

Check whether the following conditions apply to your environment:
v If you have a previous version of the product on this system, ensure that you

run the correct profile before using Version 6.1. The mqsiprofile command places
the Version 6.1 commands and libraries at the front of your search path, and
invokes any user profiles that you have supplied which can override any
combination of PATH, CLASSPATH, or library PATH.

v If you use the same user ID, and you run multiple profiles (from multiple
different installations or versions), you might get unexpected results. Log off and
log on again before you run the specific profile that you require.

Running database setup scripts

A broker requires access to a database to maintain operational and state data, and
might also require access to user databases from deployed message flows.

When you install a database product on Windows, the relevant settings are
typically made to the system environment. However, some database managers
provide a profile to perform this setup, or provide details of actions that you must
take in their documentation. Always check the database product documentation for
environment setup details; the information provided here is for general guidance
only.

If a profile is provided for the database that you are using, complete the following
steps:
1. If you can update the profile to provide permanent values for the details that

are required (for example, the database server name or the installation
directory):
a. Complete the changes to the database profile.
b. Copy the profile file to the directory work_path\common\profiles.

2. If you cannot update the profile permanently, but need to make changes each
time, you must run it independently of the mqsiprofile command before you
start the component.

When your environment has been set up, see Configuring broker and user
databases for information about setting up your databases for use with the broker.
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Command environment: Linux and UNIX systems
Set up the Linux or UNIX environment to run WebSphere Message Broker
commands.

When you start a runtime component on Linux and UNIX systems, it inherits the
environment from where you issue the mqsistart command.

You must therefore initialize the environment before you start a component; the
command mqsiprofile located in the directory install_dir/bin, performs this
initialization. If you are starting a broker, you might also need to initialize the
environment for any databases that are accessed by the broker.

You must not change the location of the mqsiprofile command, or make user
modifications to the command, because it might be replaced if you install service,
or an update, to the product.

If you want to run your own additional environment settings, add a script called
your_file_name.sh to the broker's work_path directory which contains the:
/common/profiles

subdirectory.

When you run mqsiprofile again, the command automatically calls the additional
user-written scripts in this location. The newly added script will not be picked up
if you run an mqsistart command from an existing initialized command shell.

work_path identifies the working directory defined for the broker; if you are unsure
of the work path, enter the following command:
echo $MQSI_WORKPATH

A typical reason for adding scripts is “Running database setup scripts” on page 12.

When you have configured any additional setup, you can initialize the runtime
environment for components and commands:
1. Issue the mqsiprofile command:

. install_dir/bin/mqsiprofile

You must include the period and space preceding the location for this
invocation to work correctly. Add this command to your login profile if you
want it to be run at the start of every session.
This command accesses additional scripts that you have copied to the
common/profiles directory, therefore the environment is initialized for runtime
components and other resources such as databases.

2. Start the components that you want to run on this system using the mqsistart
command.

Check if the following conditions apply to your environment:
v If you have a previous version of the product on the system, ensure that you

run the correct profile before using Version 6.1. The mqsiprofile command places
the Version 6.1 commands and libraries at the front of your search path, and
invokes any user profiles that you have supplied which can override any
combination of PATH, CLASSPATH, or library PATH.
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v If you use the same user ID, and you run multiple profiles (from multiple
different installations or versions), you might get unexpected results. Log off and
log on again before you run the specific profile that you require.

v 64-bit ODBC settings on Linux and UNIX systems are found in a text file
defined by the ODBCINI environment variable. Set ODBCINI to point to a copy of
the sample file install_dir/ODBC64/V5.3/odbc64.ini.

v 32-bit ODBC settings on Linux and UNIX systems are found in a text file
defined by the ODBCINI32 environment variable. Set ODBCINI32 to point to a copy
of the sample file install_dir/ODBC32/V5.3/odbc32.ini.

Running database setup scripts

A broker requires access to a database to maintain operational and state data, and
might also require access to user databases from deployed message flows.

When you install a database product on Linux and UNIX systems, some database
managers provide a profile to perform the environment set up that the database
requires, or provide details of actions that you must take in their documentation.
Always check the database product documentation for environment setup details;
the information provided here is for general guidance only and might not be
complete.

If you have installed 64-bit instances of DB2, Informix®, or 64-bit Oracle databases,
you need to complete additional setup steps, including adding 32-bit libraries to
MQSI_LIBPATH32. Detailed instructions are provided in Setting your environment
to support 32-bit access to databases, Creating a DB2 database on Linux and UNIX
systems, and Connecting to a database from Linux and UNIX systems: 64-bit
requirements.
1. If you can update the profile to provide permanent values for the details that

are required (for example, the database server name or the installation
directory):
a. Complete the changes to the profile.
b. Copy the profile file to the directory work_path\common\profiles.

2. If you cannot update the profile permanently, but have to change it each time,
you must run it independently of the mqsiprofile command:
a. Run the appropriate profiles to initialize the environment for the database:
v For DB2, issue the following command for the relevant DB2 instance:

. db2_instance_directory/sqllib/db2profile

v For Oracle, export ORACLE_HOME and ORACLE_SID, then issue the following
command:
. ${ORACLE_HOME}/bin/oraenv

v For Sybase, issue the following command, specifying your installation
directory:
. Sybase_installation_directory/SYBASE.sh

v For Informix, check the documentation for the client on your broker
system for details of the actions that you must take. For example, you
might have to specify the following environment variables:
export INFORMIXDIR=/installation_directory_of_informix_client_software
export PATH=${INFORMIXDIR}/bin:${PATH}
export INFORMIXSERVER=server_name
export INFORMIXSQLHOSTS=${INFORMIXDIR}/etc/sqlhosts
export TERMCAP=${INFORMIXDIR}/etc/termcap
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export TERM=vt100
export LIBPATH=${INFORMIXDIR}/lib:${INFORMIXDIR}/lib/esql:

${INFORMIXDIR}/lib/cli:$LIBPATH

where server_name is defined in the file sqlhosts (the required value is
typically the machine name), and the location of the file sqlhosts is set
up as part of the installation process.
To configure your system to run this setup at the start of every session,
add these statements to the login profile of the user that is going to run
the broker.

When your environment has been set up, see Configuring broker and user
databases for information on setting up your databases for use with the broker.

Applying service to runtime components
Apply maintenance updates and program fixes to runtime components.

Before you apply service, check that you have backed up all associated resources,
including the database used by the brokers on this computer. You might also
choose to back up installation and work path directories. For details of this task,
see Backing up resources.

You can download maintenance updates for all components of WebSphere Message
Broker from a Web site, in the form of a Program Temporary Fix (PTF), also known
as a fix pack. Fix packs are cumulative; therefore, if multiple fix packs are
available, you do not have to install a previous fix pack before you install the latest
available. However, you must first install the GA (general availability) code to
ensure that you comply with your license agreement. You can find the latest
information about current fixes by following the link Recommended fixes in the
Download section of the WebSphere Message Broker support Web page.

In some circumstances, fix packs are also provided as a media refresh; CDs and
DVDs are re-created, and electronic images on IBM Passport Advantage® are
replaced. Check with your IBM representative if you want a media refresh.

If you have installed the Trial Edition, you can apply service to this installation, if
you are within your 90 day trial period.

Fix packs for WebSphere Message Broker are installed using the same technology
as the GA release. Therefore product files are consistently tracked and updated
appropriately.

If you have applied one or more interim fixes to your existing installation, contact
your IBM Service representative for instructions and possible updated interim fixes
for the fix pack level that you are installing.

Because you can install more than one copy of WebSphere Message Broker runtime
components on a single computer, you can choose how to apply service:
1. Apply service to an existing installation.

When you apply the fix pack, the new level of the product overwrites the
existing level. You must stop all components before you apply service. All the
components and resources that you have defined are retained. When the fix
pack is successfully installed, restart the components.

2. Install the fix pack level of the product at a new location.
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Fix packs are supplied as complete installations. You can install the product in
a new location on your computer by using the fix pack packages. You can
install only within the terms of your license:
v You must have installed a GA level of the product on this computer.
v You must conform to the license restrictions for the number of installations

on a single computer; your license might permit you to install more than one
copy of the product, but allow you to run only one installation at a time.

This option provides several advantages:
v You do not have to stop components to complete the installation.
v You can choose which component runs at which service level by running the

appropriate mqsiprofile before you start the component.
v You can back out a component to the previous service level by using the

mqsiprofile from the older code level and restarting the component.
If you already have more than one installation on the computer, read the
additional information in “Applying service on computers with multiple
installations” on page 15.

Service is not affected by the operation mode in which you broker is working.

If you want to remove service that you have applied, see “Uninstalling service for
runtime components” on page 33.

Downloading a fix pack

Download the latest fix pack from the WebSphere Message Broker support Web
page:
1. Click Download to open the page of available download packages.
2. Click Recommended fixes, then click the appropriate product and version.

Available fixes are displayed.
3. Click the fix that you want to download. Details about the fix, and instructions

for download and installation, are displayed.
4. Click Problems fixed to find out what PMRs, APARs, and defects have been

fixed in the fix pack.
5. Click Release notes to read more detail about the fix pack contents.
6. Click HTTP in the Download package section to start the download process.

Accept the download terms and conditions and sign in to the download site
using your IBM ID. If you do not have an ID, you can register on this page.

7. Select your chosen operating system, and follow the instructions to apply the
maintenance updates for this fix.
a. If you are applying service to an existing installation, the installation wizard

uses this current installation directory as the default directory for typical
installations in graphical, console, and silent modes.
This location might therefore be different from the default directory that is
set for an initial typical installation on a computer on which the product has
not been installed (described in “Installation Guide” on page 3). If you have
previously installed components into non-default locations, check carefully
that you are installing the fix pack into the required location.
v Windows
v Linux and UNIX
v z/OS
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b. If you are applying service by installing an additional copy of the product,
follow the instructions provided in the “Installation Guide” on page 3,
specifying a new installation location.

Applying service on computers with multiple installations

If you have installed WebSphere Message Broker runtime components more than
once on a single computer, you can choose to apply service to one or more of these
installations in any order. You might therefore choose to install a service level on
one instance initially, and complete some tests, before you apply the fixes to
additional installations. You can also choose to run a subset of components at the
new level of service, and leave others at the original level.

You must ensure that you comply with the terms of your license at all
circumstances.

Distributed systems

You specify which installation you want runtime components to work with
by running the mqsiprofile command that is associated with that
installation. Any resources that you have defined are associated with the
installation for which you have run mqsiprofile. When the mqsiprofile
command has completed, restart the component.

If you decide to return to a previous level, stop the component, run the
mqsiprofile command that is associated with the installation at the
previous service level, and restart the component.

For further details about working with multiple installations, see
“Command environment: Windows platforms” on page 9 and “Command
environment: Linux and UNIX systems” on page 11.

z/OS systems
You can create component profiles to work with one of multiple
installations. Details are provided in “Installing service on z/OS” on page
22.

For further information about components, see z/OS customization
overview.

If you have a single installation on a computer, and you want to apply service, you
must stop all runtime components, apply service, and restart the components. The
service is applied to the product code and you can start the components
immediately to run against the new service level.

Installing service on Windows
Apply maintenance updates and program fixes to runtime components.

Before you start:

v Download the required update package for WebSphere Message Broker, as
described in “Applying service to runtime components” on page 13.

v Check that your user ID has the correct authority to complete this task; see
“Installation and uninstallation authorization” on page 69 for details.

Fix packs are supplied as self-extracting executable programs. To install the
updates that you have downloaded:
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1. Check that your user ID has the correct authority to install service for runtime
components. The requirements are defined in “Installation and uninstallation
authorization” on page 69.

2. Ensure that all WebSphere Message Broker function is stopped:
a. Stop the Configuration Manager, the User Name Server, and all brokers on

this computer by using the mqsistop command, or by stopping the
Windows services for these components from Start → Settings → Control
Panel → Administrative Tools → Services.

b. Close all instances of the workbench.
c. Check that all files associated with WebSphere Message Broker are closed.

3. Close all Windows programs before applying maintenance to WebSphere
Message Broker to ensure that data is not lost.

4. Run the fix pack self-extracting program from either Windows Explorer or the
command line.
The program is referred to as FixPackLauncher and its name is in the form
V.R.M-prod-platform-fixpack.exe, where V.R.M-prod represents the version,
release, and modification level of the product, -platform identifies the platform,
and -fixpack identifies the fix pack. For example, the file name
6.1.0-WS-MB-WINIA32-FP0001.exe identifies the file for Fix Pack 1 on Version
6.1.0 of WebSphere Message Broker on Windows.
v If you start this program from Windows Explorer, or you start it from the

command line with no options, the FixPackLauncher runs with default
options. It extracts the updates from the fix pack file, and starts the graphical
interface of the WebSphere Message Broker installation wizard.

v If you run the wizard from the command line with options, you can choose
the interface that you want to use, and how the WebSphere Message Broker
installation wizard runs.
For further details of how you can install, and other options that you can
specify, see “Installation and uninstallation interfaces” on page 63 and “How
to install and uninstall runtime components” on page 63.
If you start this wizard from a directory other than the one in which the file
is saved, you must include the fully qualified path of the file and its name.

Graphical interface
Use the following command format:
FixPackLauncher -a -gui

-gui specifies that you want use the graphical interface of the
installation program. The graphical interface is used by default if you
specify only FixPackLauncher.

For example, use either of the following commands
6.1.0-WS-MB-WINIA32-FP0001.exe

6.1.0-WS-MB-WINIA32-FP0001.exe -a -gui

Console interface
Use the following command format:
FixPackLauncher -a -console

-console specifies that you want to run the installation program
console interface. You must specify this option if you want the
installation to use this interface.

For example:
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6.1.0-WS-MB-WINIA32-FP0001.exe -a -console

Silent interface
Use the following command format:
FixPackLauncher -s -a -options "path" -silent

-s specifies that you want the extraction to use its silent interface.
You must specify this option if you want the extraction to be
completed without interaction.

-a specifies that you want to pass options to the installation
program.

-options "path" specifies the path to the silent installation response
file.

-silent specifies that you want the installation program to run in
use its silent interface.

If you do not specify a response file, the default options are used
from the supplied response file. If you want to tailor the options to
suit your installation requriements, create your own response file and
specify its location on the command.

For example, to run both the extractor program and the WebSphere
Message Broker installation program silently with a response file,
enter the following command:
FixPackLauncher -s -a -options "C:\response1.txt" -silent

5. If you use the graphical or console interface of the WebSphere Message Broker
installation program, follow the prompts given and provide any input that is
required to complete the installation.

6. If you run the fix pack installation program or the WebSphere Message Broker
installation program silently, check the installation log to ensure that the
process was successful. File mqsi6_install.log is stored in your home
directory,
The location of your home directory is typically C:\Documents and
Settings\UserID on Windows XP and Windows Server 2003, and
C:\users\UserID on WindowsVista and later operating systems. If you are
unsure of your home directory, enter echo %HOMEPATH% on the command line;
your home directory is displayed.

7. When installation has successfully completed, review the release notes that are
supplied in the directory readmes, and complete any manual post-installation
tasks that are required.

8. If you have defined ODBC connections for brokers on this computer, you must
update the ODBC definitions before you restart your brokers.
This task is described in “Windows: changing the ODBC connection and XA
resource manager definitions for V6.1.0.2 or later.”

9. When you have completed any required ODBC changes, restart the components
by using the mqsistart command.

Windows: changing the ODBC connection and XA resource
manager definitions for V6.1.0.2 or later
Update definitions for Oracle and Sybase databases when you apply service to
update brokers from Version 6.1.0.0 or Version 6.1.0.1 to Version 6.1.0.2 or later.
Change ODBC connections and XA resource manager definitions to match the
supplied version of the ODBC drivers.
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WebSphere Message Broker includes versions of the ODBC drivers that are
supplied by DataDirect Technology (formerly Merant) that are updated from
Version 6.1.0.2 onwards. These ODBC drivers are for Oracle and Sybase databases.
If you are applying service to a broker at Version 6.1.0.0 or 6.1.0.1, you must make
a number of changes as a result of the later versions of the ODBC drivers for
Oracle and Sybase databases before you can restart your brokers.
v If you are applying service updates to a Version 6.1.0.0 or Version 6.1.0.1 broker,

update the ODBC definition for each broker and user data source name.
Complete this task for Oracle and Sybase databases only.

v If you have a message flow that updates an Oracle or Sybase database within a
global unit of work that is coordinated by the broker queue manager, you must
also change the XA resource manager definition for the database.

You do not need to take these actions if you are upgrading from Version 6.1.0.2 to
a later release.

The following sections describe the changes in detail.

Changing the ODBC connection definitions:

To change the ODBC connection definitions:
1. Open the ODBC Data Source Administrator window.
2. Open the System DSN page.
3. For each Oracle and Sybase database that is accessed by the broker, associate

the data source name with the new ODBC driver:
a. Delete the data source by clicking Remove.
b. Re-create the data source with the new ODBC driver by clicking Add.
The following table displays the name of the new ODBC driver for each
database management system (DBMS).

DBMS New ODBC driver

Oracle MQSeries® DataDirect Technologies 5.30 32-BIT Oracle

Sybase MQSeries DataDirect Technologies 5.30 32-BIT Sybase Wire Protocol

Changing the XA resource manager definitions:

To change the XA resource manager definitions:
1. Open the Properties window of the broker queue manager using the

WebSphere MQ Services snap-in.
2. Open the Resources page.
3. For each Oracle and Sybase database that participates in a global unit of work,

coordinated by the broker queue manager, change the contents of the
SwitchFile field. The following table specifies what you need to change for
each database management system (DBMS). WBIMB represents the fully
qualified path name of the directory in which you have installed WebSphere
Message Broker.

DBMS Change ... To ...

Oracle WBIMB\bin\ukor8dtc22.dll WBIMB\bin\ukor8dtc23.dll

Sybase WBIMB\bin\ukase22.dll WBIMB\bin\ukase23.dll
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Installing service on Linux and UNIX
Apply maintenance updates and program fixes to product components.

Before you start:

v Download the required update package for WebSphere Message Broker, as
described in “Applying service to runtime components” on page 13.

v Check that your user ID has the correct authority to complete this task; see
“Installation and uninstallation authorization” on page 69 for details.

To install the updates that you have downloaded:
1. Check that your user ID has the correct authority to uninstall runtime

components. The requirements are defined in “Installation and uninstallation
authorization” on page 69.

2. Log in to the system. On AIX®, you must log in as root. On Linux and on
other UNIX computers, your user ID must have root authority to complete
installation. Follow your local security guidelines to acquire root authority;
either log in as root, or log in as another user and become root.

3. Stop all components that are running on this computer by using the mqsistop
command. If you are applying service on a computer that is running Linux on
x86, close all instances of the workbench.
Check that all files associated with WebSphere Message Broker are closed.

4. Change to the directory where you downloaded the fix pack file. The file
name is in the form V.R.M-prod-platform-fixpack.tar.z, where V.R.M-prod
represents the version, release, and modification level of the product, -platform
identifies the platform, and -fixpack identifies the fix pack. For example, the
file name 6.1.0-WS-MB-AIXPPC64-FP0001.tar.z identifies the file for Fix Pack 1
on Version 6.1.0 of WebSphere Message Broker on AIX.

5. Replace the .z file with a .tar file, by entering the following command:
uncompress -fv V.R.M-prod-platform-fixpack.tar.z

6. Untar the image and extract all the directories, subdirectories, and files
required to apply the update, by entering the following command:
tar -xvf V.R.M-prod-platform-fixpack.tar

7. Decide which interface you want to use for the installation; -graphical (the
default option if none is specified), -console, or -silent. For further details of
how you can run and installation, and other options that you can specify, see
“Installation and uninstallation interfaces” on page 63 and “How to install
and uninstall runtime components” on page 63.

8. Depending on the choice you have selected, run one of the following
commands, where installer is the appropriate installation program for your
platform, listed in the table.
v To use the installation wizard graphical interface, type the installer name

with no options at a command prompt, and press Enter. Include the
absolute or relative path names if you start installation from a directory
other than the one in which the wizard exists. When you start the
installation wizard, it guides you through a series of panels where you can
make choices about where to install the components, and which
components you want to install.

v To use the installation wizard console interface, enter installer -console.
Include the absolute or relative path names if you start installation from a
directory other than the one in which the wizard exists. When you start the
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installation wizard, it prompts you to enter input for all options, including
where to install the components, and which components you want to
install.

v To use the installation wizard silent interface, enter installer -silent.
Include the absolute or relative path names if you start installation from a
directory other than the one in which the wizard exists. If you want to
specify non-default settings, include a response file on the command. For
more details of how to specify a response file, and how to create and edit a
response file to define your requirements, see “Using response files with
runtime components” on page 65.

Platform Installation program

AIX setupaix

HP-Itanium® setuphpia64

HP-UX on PA-RISC setuphp

Linux on POWER® setuplinuxppc

Linux on x86 setuplinuxia32

Linux on x86-64 setuplinuxx64

Linux on System z® setuplinux390

Solaris on SPARC setupsolaris

Solaris on x86-64 setupsolarisx64

The installer extracts the update files and runs according to the arguments
supplied.

9. Follow the instructions presented by the installation program and provide all
input that is required to complete the installation.
When installation has successfully completed, review the release notes that are
supplied in the directory readmes, and complete all manual post-installation
tasks that are required.

10. If you have defined ODBC connections for brokers on this computer, you
must update the odbc32.ini and odbc64.ini files before you restart your
brokers.
To change your files when you apply service from V6.1.0.0 or V6.1.0.1 to
V6.1.0.2 or later, follow the instructions in “Linux and UNIX: changing the
ODBC connection and XA resource manager definitions for V6.1.0.2 or later.”

11. When you have completed any required ODBC changes, restart the
components by using the mqsistart command.

Linux and UNIX: changing the ODBC connection and XA
resource manager definitions for V6.1.0.2 or later
Update definitions for Oracle and Sybase databases when you apply service to
update brokers from Version 6.1.0.0 or Version 6.1.0.1 to Version 6.1.0.2 or later.
Change ODBC connections and CA resource manager definitions to match the
supplied version of the ODBC drivers.

WebSphere Message Broker includes versions of the ODBC drivers that are
supplied by DataDirect Technology (formerly Merant) that are updated from
Version 6.1.0.2 onwards. These ODBC drivers are for Oracle and Sybase databases.
If you are applying service to a broker at Version 6.1.0.0 or 6.1.0.1, you must make
a number of changes as a result of the later versions of the ODBC drivers for
Oracle and Sybase databases before you can restart your brokers.
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v If you are applying service updates to a Version 6.1.0.0 or Version 6.1.0.1 broker,
update the ODBC definition for each broker and the user data source name.
Complete this task for Oracle and Sybase databases only.
Use the template supplied with the service level that you are applying to
complete this task, as described in Connecting to a database from Linux and
UNIX systems: 64-bit requirements or Connecting to a database from Linux and
UNIX systems: 32-bit requirements. Do not change the existing definition file.

v If you have a message flow that updates an Oracle or Sybase database within a
global unit of work that is coordinated by the broker queue manager, you must
also change the XA resource manager definition for the database.

You do not need to take these actions if you are upgrading from Version 6.1.0.2 to
a later release.

The following sections describe the changes in detail.

Changing the ODBC connection definitions:

Create a new ODBC definitions file by following the instructions in Connecting to
a database from Linux and UNIX systems: 64-bit requirements or Connecting to a
database from Linux and UNIX systems: 32-bit requirements. Before you run the
commands at the new service level, check that your ODBCINI environment
variable points to the new file and not to the existing file.

Changing the XA resource manager definitions:

To change the XA resource manager definitions on a Linux or UNIX system, edit
the queue manager configuration file (qm.ini) of the broker queue manager. This
file is in the queue manager's directory.

In the XAResourceManager stanza for each Oracle and Sybase database that
participates in a global unit of work, coordinated by the broker queue manager,
change the entry for the switch file. The following tables specify what you need to
change for each broker operating system and database management system
(DBMS).

UNIX Complete the following changes on AIX, HP-Itanium, Solaris, and Linux
(excluding Linux on System z, on which Sybase is not supported).

DBMS Change ... To ...

Oracle SwitchFile=UKor8tdc22.so SwitchFile=UKor8dtc23.so

Sybase SwitchFile=UKasedtc22.so SwitchFile=UKasedtc23.so

HP�UX Complete the following changes on HP-UX on PA-RISC.

DBMS Change ... To ...

Oracle SwitchFile=UKor8tdc20.sl SwitchFile=UKor8dtc23.sl

Sybase SwitchFile=UKasedtc20.sl SwitchFile=UKasedtc23.sl

Installing 21



Installing service on z/OS
Apply maintenance updates to product components.

Before you start:

v Download the required update package for WebSphere Message Broker, as
described in “Applying service to runtime components” on page 13.

v Check that your user ID has the correct authority to complete this task; see
“Installation and uninstallation authorization” on page 69 for details.

Use this three stage process to install service on z/OS:
1. Store the updates on your target system.
2. Install and test the fix pack. If testing is not satisfactory, you can remove this fix

pack at this stage.
3. After testing, confirm the fix pack as your current base level of installation.

Follow these instructions to complete the process:
1. Receive the updates. Use SMP/E RECEIVE to transfer the contents of the fix

pack from the tape or the downloaded package to your system at the specified
location.

2. Apply the updates. Use SMP/E APPLY to install the fix pack which completes
the link edit steps and generates a runtime environment in your chosen
location.
The installation process completes updates to USS and to four product data sets
(SBIPSAMP, SBIPINST, SBIPPROC, and SBIPAUTH).
If your SMP/E target system is not on the same file system as your production
system, copy the data sets (including the data set that represents your USS
mount point) to the system where they are to be used, overwriting the current
content. When you complete this action, all runtime components use the
updated data sets when they next restart.
If you do not want all your components to use the updated installation, copy
the data sets to a different location and start selected components against that
copy. Further details are provided in “Multiple concurrent installations at
different levels.”
You can specify the same destination for receiving the fix pack contents (the
SMP/E target system) and for installing (the production system). If you specify
a different location, you must copy the product data sets to the appropriate
location.
When you have installed the fix pack, test it to ensure that it is working
correctly in your environment. If you find problems at this stage, you can
remove the fix pack by using SMP/E RESTORE. The command restores your
installation to the level that you last accepted (SMP/E ACCEPT).

3. Confirm the update. Use SMP/E ACCEPT to commit the changes and to
establish this fix pack as the current level. When you have completed this step,
you cannot restore your system to a previous service level. If you want to use
an earlier service level, you must reinstall that level.

Multiple concurrent installations at different levels

If you want to install a later fix pack level, and retain your existing installation so
that you can use both service levels, install the second level in a different location.
You can then set up additional customization so that one or more of your existing
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runtime components can use the second service level. By retaining the product files
in the first location, you can switch a component back to the first level, if required.

For example, you might choose to change one broker to use the later service level,
but keep your Configuration Manager at the original service level until you have
completed some tests on the updated broker.

The following steps are a summary of the tasks that you must complete to run
components at one service level concurrently with components at another service
level. These steps are identical to those you take for setting up an initial
installation, except where indicated.

For a full description of installation and customization for each component, see
Creating a broker on z/OS, Creating a Configuration Manager on z/OS, and
Creating a User Name Server on z/OS.
1. To install a second service or fix pack level:

a. Install the second level of the product components by using the instructions
provided with that level.

b. Copy all the template data sets and the main files from the HFS file system
to a unique location.

2. To prepare components for use with the second installation:
a. Create and customize a new component data set. For example, if you want

to create a new broker component, complete the steps described in
Customizing the broker component data set.

b. Copy the template JCL from the second location to the new dataset.
c. Customize the JCL to work with the second location, but use the existing

queue manager definition that you are using with the first location. If the
component is a broker, use the existing database definition too. For more
details about this step, see the appropriate task for your component, for
example Customizing the broker JCL.

3. To change a component to work with the second installation:
a. Submit the BIPGEN job to update the environment file ENVFILE for the

component. This task is described in Creating the environment file.
b. Copy the customized started task from the new data set into the procedures

library, for example USER.PROCLIB.
c. Start the component; the component is now associated with the second

location.
4. To roll back to the previous version:

a. Open the original component data set, that is associated with the first
location.

b. Resubmit the BIPGEN job from that data set.
c. Copy the original PROC into the procedures library USER.PROCLIB.
d. Stop and restart the component.

Applying service to the Message Broker Toolkit
Apply maintenance updates and program fixes to the Message Broker Toolkit.

Before you apply a fix pack or other service pack to the Message Broker Toolkit,
you might want to preserve the resources that you have created or imported into
Version 6.1. For details of this task, see Backing up the Message Broker Toolkit
workspace.
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Check that your user ID has the correct authority to complete this task; see
“Installation and uninstallation authorization” on page 69 for details.

The Message Broker Toolkit uses IBM Installation Manager to install service
updates. Occasionally, an update is also required to Installation Manager; for
example, if you upgrade from Version 6.1.0.0 or Version 6.1.0.1 to Version 6.1.0.2,
you must apply service to Installation Manager before you can apply service to the
Message Broker Toolkit.

Occasionally, updates to the information center are also made available. These
updates are integrated with component updates when they are made available,
and are therefore automatically included when you apply any updates using these
instructions.

If you have installed the Trial Edition, you can apply service to this installation,
provided that you are within your 90 day trial period.

For information about current fixes, follow the link Recommended fixes in the
Download section of the WebSphere Message Broker support Web page. Click the
link for Version 6.1, and select the updates you want to apply. Service release
notes, the list of problems fixed in a fix pack or other maintenance release, and the
instructions you must follow to complete the service upgrade are available. The
instructions provide full details of how to apply each service fix, and include
information about fixes to Installation Manager, if required. Always use those
instructions in preference to the information in this topic, because they are
maintained regularly and provide the latest information.

If you want Installation Manager to retrieve updates from a different location, see
“Changing the update repositories for Installation Manager” on page 25. If you use
FTP or HTTP proxies to allow applications to access the Internet, see “Setting FTP
and HTTP proxies for Installation Manager” on page 26.

Use Installation Manager for all service updates, including those to Installation
Manager itself. In most cases, the following instructions are sufficient; occasionally,
further steps are necessary, therefore you must always check with the instructions
provided with each fix on the support Web site.
1. Start Installation Manager by using one of the following two methods:
v From the Linux main menu or the Windows Start menu:

– Linux On Linux, you can use this option only if you are logged in as
root. If you have logged in as another user, you cannot use the main
menu links, even if you become root.
- On Red Hat, click System → IBM Installation Manager.
- On SUSE, click System Tools → IBM Installation Manager.

– Windows On Windows, click Start → Programs → IBM Installation
Manager → IBM Installation Manager.

v From the command line:
Navigate to the eclipse subdirectory in the directory in which Installation
Manager is installed and run the following command:

– Linux IBMIM

– Windows IBMIM.exe

Installation Manager opens and displays its initial panel.
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2. Click Update Packages, then select the package group in which you have
installed the Message Broker Toolkit.

3. Click Next. Installation Manager searches the selected update site or sites, and
displays a list of available updates for the products and features that you have
installed.
Initially Show recommended (below the list) is selected, and the latest updates
only are shown. To include earlier updates as well, select Show all.
See “Changing the update repositories for Installation Manager” for
information about how you can change the locations that are searched.

4. Select the updates that you want to apply and click Update. The updates are
applied.

5. Click OK to return to the Installation Manager initial panel.
6. Click File → Exit to close Installation Manager.

If you want to remove service that you have applied, see “Uninstalling service
from the Message Broker Toolkit” on page 37.

Changing the update repositories for Installation Manager
If you have a large number of Message Broker Toolkit users, or your users do not
have regular access to the Internet, you might find it more convenient to download
updates to a local site or server, and modify Installation Manager to access the
updates at that alternative site.

For example, if you want to limit Internet access to a restricted set of computers, or
if you want to reduce download times, or both, you can set up local repositories
that your users can access to apply updates.

To set up alternative repositories:
1. Start Installation Manager from the Start menu (on Windows) or main menu

(on Linux on x86), or from the command line. Installation Manager opens and
displays its initial panel.

2. Click File → Preferences. The Preferences dialog is displayed.
3. Click Repositories in the left pane. The Repositories page is displayed.
4. Click Add Repository. If you know the name and location of the update

repositories that Installation Manager is to search, enter the URL or fully
qualified location of the update file, including the repository name; for
example, repository.config.
To search for repositories, which can be on a local or a remote computer, click
Browse and navigate to the correct location. The field File of type lists the
values repository.config, diskTag.inf, .jar, and .zip, and repositories with
these names and types are searched for by default. The identity of an update
depends on what type of update it is (for example, disk images are named
diskTag.inf),
If you are not sure what updates you might want, leave the contents of field
File of type unchanged; all available updates are shown. Click the required
repository to select it, then click Open. The repository is added to the displayed
list of repositories. If the repository is not connected, a red cross is displayed in
the Connection column. You might need to check your network connections, or
try again at a later time.
When it is added to the list, the repository is initially shown as selected, to
indicate that its contents will be included when you run Installation Manager
to update packages.
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Repeat this step to add additional repositories if appropriate from the same or
another location. You can have one or more locations selected at any time;
Installation Manager searches all selected repositories listed on the Repositories
page.

5. If you want Installation Manager to search only the repositories that you have
added, clear Search service repositories during installation and update. The
service repositories are those locations on the product support Web sites that
host updates. If you clear this option, the default service repositories are not
searched. The service repositories location is fixed and predefined; you cannot
change it.

6. Click OK on the Browse panel if you opened it, and click OK on the
Repositories page.

7. Click Apply to confirm the update, then click OK to close the Preferences
dialog box.

To remove a repository from the selected list, clear its selection. If you want to
delete a repository in the list, select the repository and click Remove Repository.
To clear selection of all listed repositories, click Clear Credentials.

Setting FTP and HTTP proxies for Installation Manager
If your environment has a firewall, or uses proxies to control access to the Internet,
you can change the Installation Manager settings to enhance your access security.

You do not have to complete this task if you have changed the Installation
Manager repository location to a local site.

Complete the following steps:
1. Start Installation Manager from the Start menu (on Windows) or main menu

(on Linux on x86), or from the command line. Installation Manager opens and
displays its initial panel.

2. Click File → Preferences. The Preferences dialog is displayed.
3. Expand the Internet tree in the left pane, and select FTP Proxy or HTTP Proxy.
4. Select Enable proxy server and enter the details in the entry fields that are

required for the protocol that you selected.
5. Click Apply to confirm the updates, then click OK to close the Preferences

dialog box.
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Uninstalling

Remove runtime components or the Message Broker Toolkit from your computer.

Before you start:

Check that your user ID has the correct authority to complete this task. The
requirements for each platform are defined in “Installation and uninstallation
authorization” on page 69.

Follow the appropriate link for the task that you want to complete:
v “Uninstalling runtime components”
v “Uninstalling the Message Broker Toolkit” on page 34

You might also want to uninstall complementary products. See the documentation
provided by those products to complete this task:
v IBM DB2: Access the appropriate information for your installation:

– DB2 V9.1 Information Center (distributed systems)
– DB2 V9.5 Information Center (distributed systems)
– DB2 V8 Information Center (distributed systems)
– DB2 Information Center (z/OS) (Versions 8 and 9)

v IBM Tivoli License Manager: access the IBM Tivoli License Manager Information
Center

Uninstalling runtime components
You can uninstall the runtime components on distributed systems in a number of
ways.

This section describes this task for the following systems:
v AIX
v HP-UX
v Linux
v Solaris
v Windows

If you are uninstalling on Linux or UNIX systems, make sure that the directory
/var is not full; the uninstallation wizard requires space in this directory while it is
running.
1. Check that your user ID has the correct authority to uninstall runtime

components, or to uninstall service that you have applied. The requirements are
defined in “Installation and uninstallation authorization” on page 69.

2. If you are uninstalling one or more runtime components, decide which mode of
uninstallation you want to use. The choices are explained in “How to install
and uninstall runtime components” on page 63.

3. Follow the uninstallation instructions provided in the appropriate topic:
v “Uninstalling runtime components with the graphical interface” on page 30
v “Uninstalling runtime components with the console interface” on page 31
v “Uninstalling runtime components with the silent interface” on page 32
v “Uninstalling service for runtime components” on page 33
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If, in exceptional circumstances, the uninstall wizard fails to remove the product
successfully, you can remove the product manually. Contact your IBM Service
Center for assistance if a failure occurs.

For information about removing service updates, see “Uninstalling service for
runtime components” on page 33.

Uninstalling runtime components with the graphical interface
Remove the runtime components by using the graphical interface.

Always use the WebSphere Message Broker uninstall wizard to remove product
components, unless otherwise stated. Do not use the uninstallation program that is
provided by the operating system; for example, geninstall on AIX, or swremove on
HP-UX.

On HP-UX Version 11.23, and on Linux on POWER, a known restriction prevents
the creation of the uninstall wizard. If this situation occurs, use the alternative
command specified in these instructions. Also check the readme.html file to ensure
that no additional operating systems are affected by this restriction.

For information about the graphical interface and alternative interfaces available,
see “How to install and uninstall runtime components” on page 63.

To start the graphical interface of the uninstaller, complete the following steps:
1. Stop all running processes that are associated with runtime components

(broker, Configuration Manager and User Name Server) before you uninstall.
Use the mqsilist command to check which components are running. Use the
mqsistop command to stop each component.

2. On Windows and Linux on x86, end all active sessions of the Message Broker
Toolkit.

3. If you do not plan to reinstall components on this computer, delete all the
brokers (mqsideletebroker command), Configuration Managers
(mqsideleteconfigmgr command), and User Name Servers
(mqsideleteusernameserver command) that are associated with this installation.
When you delete a component, all its associated data and resources are deleted;
if you want to retain component data, do not delete that component.

4. If you have created DB2 or Derby databases on Windows with the
mqsicreatedb command, delete them with the mqsideletedb command. If you
delete the last database, the Database Instance Manager is also deleted (the
Database Instance Manager controls all appropriate databases in a single
system; if you have another installation, this component might not be deleted if
databases that are associated with the other installation remain). Databases that
have been created by the Default Configuration wizard can also be deleted in
this way.

5. Run the following command from outside the installation directory, specifying
the full path (this method of invocation ensures that the full directory structure
is removed during uninstallation):
v On HP-UX systems running Version 11.23 only, and on Linux on POWER

systems:
/install_dir/_uninst_runtime_jvm/jre/bin/java -jar /install_dir/_uninst_runtime/uninstall.jar

v On all other operating systems:
install_dir/_uninst_runtime/uninstaller
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where install_dir is the home directory of your WebSphere Message Broker
installation.
If you accepted the default location during installation, this directory is as
follows:
v On Windows 32-bit editions, C:\Program Files\IBM\MQSI\6.1

v On Windows 64-bit editions, C:\Program Files(x86)\IBM\MQSI\6.1

v On AIX, HP-UX, and Solaris, /opt/IBM/mqsi/6.1
v On Linux, /opt/ibm/mqsi/6.1
Alternatively, if you have a single installation of runtime components on
Windows, you can navigate to Start → Settings → Control Panel → Add/Remove
Programs. Select WebSphere Message Broker and click Change/Remove. The
uninstaller graphical interface opens.

6. Choose the component or components that you want to uninstall and follow
the prompts to complete uninstallation.

Uninstalling runtime components with the console interface
Remove the runtime components by using the console interface.

Always use the WebSphere Message Broker uninstall wizard to remove product
components, unless otherwise stated. Do not use the uninstallation program that is
provided by the operating system; for example, geninstall on AIX, or swremove on
HP-UX.

On HP-UX Version 11.23, and on Linux on POWER, a known restriction prevents
the creation of the uninstall wizard. If this situation occurs, use the alternative
command specified in these instructions. Also check the readme.html file to ensure
that no additional operating systems are affected by this restriction.

For information about the console interface and alternative interfaces available, see
“How to install and uninstall runtime components” on page 63.

To start the console interface of the uninstaller, complete the following steps:
1. Stop all running processes that use any part of WebSphere Message Broker

(brokers, Configuration Manager, and the User Name Server) before you
uninstall. Use the mqsilist command to check which components are running.
Stop each component using the mqsistop command.

2. On Windows and Linux on x86, end any active sessions of the Message Broker
Toolkit.

3. If you do not plan to reinstall components on this computer, delete all the
brokers (mqsideletebroker command), Configuration Managers
(mqsideleteconfigmgr command), and User Name Servers
(mqsideleteusernameserver command) that are associated with this installation.
When you delete a component, all its associated data and resources are deleted;
if you want to retain component data, do not delete that component.

4. If you have created DB2 or Derby databases on Windows with the
mqsicreatedb command, delete them with the mqsideletedb command. If you
delete the last database, the Database Instance Manager is also deleted (the
Database Instance Manager controls all appropriate databases in a single
system; if you have another installation, this component might not be deleted if
databases associated with the other installation remain). Databases created by
the Default Configuration wizard can also be deleted in this way.
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5. Run the uninstallation program from outside the installation directory,
specifying the full path to ensure that the folders are removed during
uninstallation.
v On HP-UX systems that are running Version 11.23 only, and on Linux on

POWER systems:
/install_dir/_uninst_runtime_jvm/jre/bin/java -jar /install_dir/_uninst_runtime/uninstall.jar -console

v On all other operating systems:
install_dir/_uninst_runtime/uninstaller -console

where install_dir is the home directory of your WebSphere Message Broker
installation.
If you accepted the default location during installation, this directory is as
follows:
v On Windows 32-bit editions, C:\Program Files\IBM\MQSI\6.1

v On Windows 64-bit editions, C:\Program Files(x86)\IBM\MQSI\6.1

v On AIX, HP-UX, and Solaris, /opt/IBM/mqsi/6.1
v On Linux, /opt/ibm/mqsi/6.1

6. When started, the uninstaller presents text-based screens on the console.
Navigate between these screens using the following options:
v 1 next
v 2 previous
v 3 cancel
v 4 redisplay

The uninstaller asks you to confirm that you want to uninstall the product and
that the location it is uninstalling from is correct. When you have responded to
these questions, the uninstallation starts.

Uninstalling runtime components with the silent interface
Remove the runtime components without user interaction by using the silent
interface.

Always use the WebSphere Message Broker uninstall wizard to remove product
components, unless otherwise stated. Do not use the uninstallation program that is
provided by the operating system; for example, geninstall on AIX, or swremove on
HP-UX.

On HP-UX Version 11.23, and on Linux on POWER, a known restriction prevents
the creation of the uninstall wizard. If this situation occurs, use the alternative
command specified in these instructions. Also check the readme.html file to ensure
that no additional operating systems are affected by this restriction.

If you use the silent interface to uninstall runtime components, the wizard always
uninstalls components from the last known Version 6.1 installation location (that is,
the most recent installation), regardless of the location of the uninstallation wizard
that you start. If you want to remove components from an earlier Version 6.1
installation, use the console or graphical interface.

You can remove WebSphere Message Broker without user interaction. This process
is called unattended (or silent) removal. This topic describes how to run the
uninstallation program silently without a response file; the program assumes all
the default values.
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If you want to complete a silent uninstallation, but have non-default requirements,
you can use a response file. A response file is a text file that contains values for the
options that you select when you uninstall WebSphere Message Broker. For more
details of how to create, edit, and employ a response file to specify your
requirements, see Using response files.

For information about the silent interface and alternative interfaces available, see
“How to install and uninstall runtime components” on page 63.

To start the silent interface of the uninstaller, complete the following steps:
1. Stop all running processes that use any part of WebSphere Message Broker

(brokers, Configuration Manager, and the User Name Server) before you
uninstall. Use the mqsilist command to check which components are running.
Stop each component using the mqsistop command.

2. On Windows and Linux on x86, end any active sessions of the Message Broker
Toolkit.

3. If you do not plan to reinstall components on this computer, delete all the
brokers (mqsideletebroker command), Configuration Managers
(mqsideleteconfigmgr command), and User Name Servers
(mqsideleteusernameserver command) that are associated with this installation.
When you delete a component, all its associated data and resources are deleted;
if you want to retain component data, do not delete that component.

4. If you have created DB2 or Derby databases on Windows with the
mqsicreatedb command, delete them with the mqsideletedb command. If you
delete the last database, the Database Instance Manager is also deleted (the
Database Instance Manager controls all appropriate databases in a single
system; if you have another installation, this component might not be deleted if
databases associated with the other installation remain). Databases created by
the Default Configuration wizard can also be deleted in this way.

5. Run the following command from outside the installation directory, specifying
the full path (this method of invocation ensures that the full directory structure
is removed during uninstallation):
v On HP-UX systems that are running Version 11.23 only, and on Linux on

POWER systems:
/install_dir/_uninst_runtime_jvm/jre/bin/java -jar /install_dir/_uninst_runtime/uninstall.jar -silent

v On all other operating systems:
install_dir/_uninst_runtime/uninstaller -silent

where install_dir is the home directory of your WebSphere Message Broker
installation.
If you accepted the default location during installation, this directory is as
follows:
v On Windows 32-bit editions, C:\Program Files\IBM\MQSI\6.1

v On Windows 64-bit editions, C:\Program Files(x86)\IBM\MQSI\6.1

v On AIX, HP-UX, and Solaris, /opt/IBM/mqsi/6.1
v On Linux, /opt/ibm/mqsi/6.1

The uninstallation program runs without interaction.

Uninstalling service for runtime components
On some platforms, you can remove fixes that you have applied.

Distributed systems
You cannot remove individual fixes that you have applied to runtime

Uninstalling 33



components on distributed systems. If you want to restore a system to a
previous service level, you must uninstall the product before you reinstall
the required level of service.

If you have a single installation on your computer, create and retain a
backup image, or keep previous GA or fix pack images or media, in case
you experience problems after you have installed service. If you have
multiple installations, each one can be at a different service level and you
can transfer the runtime components to work with an alternative
installation at a newer or older level of service. This option is described in
“Applying service to runtime components” on page 13.

When you uninstall the product, the components that you have created are
not lost, and you can continue to use these components and associated
resources with the reinstalled product. However, you might want to take a
backup of the installation and work path directories before you start this
procedure.

To restore a system on which you have a single installation to a previous
service level:
1. Uninstall the entire product.
2. Reinstall the GA level of the product. This step is required to ensure

that you comply with your license agreement.
3. Install the required level of fix pack.

z/OS On z/OS systems, you can uninstall service levels under some
circumstances during the installation phase; for further information, see
“Installing service on z/OS” on page 22.

Uninstalling the Message Broker Toolkit
Choose the method that you want to use to uninstall the Message Broker Toolkit
and follow the instructions to remove the component.

Complete the following steps to uninstall the Message Broker Toolkit:
1. Check that your user ID has the correct authority to uninstall the Message

Broker Toolkit or to uninstall service that you have applied. The requirements
are defined in “Installation and uninstallation authorization” on page 69.

2. If you are uninstalling the Message Broker Toolkit component, decide which
mode of uninstallation you want to use. The choices are explained in “How to
install and uninstall the Message Broker Toolkit” on page 67.

3. Follow the instructions provided in the appropriate topic:
v “Uninstalling the Message Broker Toolkit in graphical mode” on page 35
v “Uninstalling the Message Broker Toolkit in silent mode” on page 36
v “Uninstalling service from the Message Broker Toolkit” on page 37

When you uninstall the Message Broker Toolkit component, entries are removed
from the system menus:

Linux If you have installed the Message Broker Toolkit more than once on
Linux on x86, the main menu shows a single entry, regardless of the number of
installations that you have completed; the entry always accesses the last
installation that you completed. When you uninstall this component, the single
entry is removed, and you cannot access remaining installations using the main
menu. Navigate to the correct package group installation directory and start the
Message Broker Toolkit from the command line.
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Windows Entries in the Windows Start menu are grouped by package group.
When you uninstall this component, the entry within the appropriate package
group is correctly removed.

Uninstalling the Message Broker Toolkit in graphical mode
The graphical interface guides you through the process of uninstalling the Message
Broker Toolkit.

For information about the modes that are available, see “How to install and
uninstall the Message Broker Toolkit” on page 67.

Complete the following steps:
1. Log on to the computer on which Message Broker Toolkit is installed with a

user ID that has the correct authority. The authority requirements are defined in
“Installation and uninstallation authorization” on page 69.

2. Start IBM Installation Manager.

v Linux Choose one of the following options:
– The main menu. You can use this option only if you are logged in as root.

If you have logged in as another user, you cannot use the main menu
links, even if you become root.
- On Red Hat, click System → IBM Installation Manager.
- On SUSE, click System Tools → IBM Installation Manager.

– Navigate to the eclipse subdirectory in the directory in which Installation
Manager is installed and run the command IBMIM.

– On the command line, start the Message Broker Toolkit uninstallation
wizard (where package_group_dir is the directory in which you have
installed the package group):
package_group_dir/uninstall/uninstall.sh

For example:
/opt/IBM/WMBT610/uninstall/uninstall.sh

v Windows Choose one of the following options:
– Click Start → Programs → IBM Installation Manager → IBM Installation

Manager.
– Click Start → Settings → Control Panel → Add/Remove Programs. Open the

package group and select the package group in which you have installed
Message Broker Toolkit, for example IBM Software Development
Platform_1.

– Navigate to the eclipse subdirectory in the directory in which Installation
Manager is installed and run the command IBMIM.exe.

– On the command line, start the Message Broker Toolkit uninstallation
wizard (where package_group_dir is the directory in which you have
installed the package group):
package_group_dir\uninstall\uninstall.bat

For example, on Windows XP:
C:\Program Files\IBM\WMBT610\uninstall\uninstall.bat

3. If you started Installation Manager from the Start or main menu, or by running
IBMIM or IBMIM.exe, click Uninstall Packages. The Uninstall Package panel
displays.

4. Select the Message Broker Toolkit, then click Next. The Uninstall Summary
panel is displayed.
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5. Check that the items listed are those that you want to uninstall. Click Back if
you want to make changes, or click Uninstall to continue. The uninstallation
process starts.

6. Follow the guidance through the series of panels, providing input and
responses as required.

7. When the process completes, check the log file for errors. The file
YYYYMMDD_TIME.xml is written to the following directory:
v Linux /var/ibm/InstallationManager/logs

v Windows %ALLUSERSPROFILE%\Application Data\IBM\Installation
Manager\logs where %ALLUSERSPROFILE% is the environment variable that
defines the system working directory. The default directory depends on the
operating system:
– On Windows XP and Windows Server 2003: C:\Documents and

Settings\All Users\Application Data\IBM\Installation Manager\logs.
– On WindowsVista and later operating systems: C:\ProgramData\IBM\

Installation Manager\logs.

The actual value might be different on your computer.
8. Restart your computer to complete the uninstallation of the Message Broker

Toolkit.

Uninstalling the Message Broker Toolkit in silent mode
Uninstall the Message Broker Toolkit without user interaction.

For information about alternative modes that are available, see “How to install and
uninstall the Message Broker Toolkit” on page 67.

Complete the following steps:
1. Log on to the computer on which Message Broker Toolkit is installed with a

user ID that has the correct authority. The authority requirements are defined in
“Installation and uninstallation authorization” on page 69.

2. To silently uninstall the Message Broker Toolkit, start IBM Installation Manager
using the supplied script files.
a. Navigate to the uninstall directory:

v Linux package_group_dir/uninstall/

For example:
/opt/IBM/WMBT610/uninstall/

v Windows package_group_dir\uninstall\

For example, on Windows XP:
C:\Program Files\IBM\WMBT610\uninstall\

b. Open the following script file in a text editor:

v Linux uninstall.sh

v Windows uninstall.bat

c. Modify the invocation of the IBMIM executable file as follows:
IM_dir/IBMIM -nosplash -input uninstall.xml -silent

Replace IM_dir/, or IM_dir\, depending on your platform, with the full path
for Installation Manager on your operating system. If you have installed
Installation Manager in the default location, the full path is:
v Linux /opt/IBM/InstallationManager/eclipse/
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v Windows On Windows 32-bit editions: C:\Program Files\IBM\
InstallationManager\eclipse\

v Windows On Windows 64-bit editions: C:\Program Files(x86)\IBM\
InstallationManager\eclipse\

Note, that on Windows you must enclose the full path name in double
quotation marks. For example:
"C:\Program Files(x86)\IBM\InstallationManager\eclipse\IBMIMc"
-nosplash -input package_group_dir\uninstall\uninstall.xml
-silent

3. Run the file that you just edited. The product is uninstalled silently; control is
returned to the command line when uninstallation is finished.

4. When the process completes, check the log file for errors. The file
YYYYMMDD_TIME.xml is written to the following directory:
v Linux /var/ibm/InstallationManager/logs

v Windows %ALLUSERSPROFILE%\Application Data\IBM\Installation
Manager\logs where %ALLUSERSPROFILE% is the environment variable that
defines the system working directory. The default directory depends on the
operating system:
– On Windows XP and Windows Server 2003: C:\Documents and

Settings\All Users\Application Data\IBM\Installation Manager\logs.
– On WindowsVista and later operating systems: C:\ProgramData\IBM\

Installation Manager\logs.

The actual value might be different on your computer.
5. Restart your computer to complete the uninstallation of the Message Broker

Toolkit.

Uninstalling service from the Message Broker Toolkit
Remove maintenance or fixes from the Message Broker Toolkit.

Linux To remove service from the Message Broker Toolkit on Linux on x86,
your user ID must have root authority. Follow your local security guidelines to
acquire root authority; either log in as root, or log in as another user and become
root.

Windows To remove service from the Message Broker Toolkit on Windows, your
user ID must have Administrator authority.

You can remove WebSphere Message Broker iFix and service updates from the
toolkit using IBM Installation Manager.

To uninstall service:
1. Close all sessions of the workbench on this computer.
2. Start Installation Manager in one of the following ways:
v From the Linux on x86 main menu or the Windows Start menu:

– On Linux, you can use this option only if you are logged in as root. If you
have logged in as another user, you cannot use the main menu links, even
if you become root.
- On Red Hat, click System → IBM Installation Manager.
- On SUSE, click System Tools → IBM Installation Manager.

– On Windows, click Start → Programs → IBM Installation Manager → IBM
Installation Manager .
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v Navigate to the eclipse subdirectory in the directory in which Installation
Manager is installed and run the following command:

– Linux IBMIM

– Windows IBMIM.exe

Installation Manager starts and displays its initial panel.
3. Click Roll Back Packages, then select the package group in which you have

installed the Message Broker Toolkit.
4. Click Next. The Roll Back Packages panel displays the products that you have

installed in the selected group. The service updates that you have applied to
any item in the list are displayed under the item to which they apply.

5. If updates are installed, select the updates that you want to remove from each
particular installation. A summary of the selected updates is displayed. Click
more details... to open the readme file associated with the fix.

6. Click Next to continue. Installation Manager checks that no workbench sessions
are running. If the check fails, an error message is displayed and you cannot
continue with the operation. Close all active sessions, then return to this step
and click Next again.
Installation Manager displays the exact identification of the fixes that you
selected; check that what is listed is correct. If you want to change your
choices, click Back to view the list of fixes again.

7. Click Roll Back. Installation Manager starts to remove the selected fixes. A
progress bar is displayed so that you can monitor the request. A completion
message is displayed; click View log to read the report that is generated by the
removal.

8. If the fix has been removed successfully, click Finish to return to the initial
panel. If the removal failed, examine the contents of the log file to determine
the cause of the error.

9. Click File → Exit to close Installation Manager.
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Installation

Use the reference information in this section to understand installation
requirements, installation options, and how they affect your computer
v “Hardware requirements”
v “Software requirements” on page 44
v “Installation and uninstallation interfaces” on page 63
v “Installation and uninstallation authorization” on page 69
v “Multicultural support” on page 69
v System changes

Read the product readme.html file to see if additional options or restrictions are in
force; this file is provided on CD (or DVD) and installed with the product. You can
find the most up-to-date version on the Web, as described in “Finding the latest
information” on page 4.

Product requirements are also available on the Web, and are occasionally updated.
Check for the latest information about WebSphere Message Broker Requirements.

Hardware requirements
View the processor and related hardware requirements on all platforms.
v “Supported processors”
v “Memory and disk space requirements” on page 42
v “Communications” on page 44

Supported processors
WebSphere Message Broker is supported on multiple processors.

The hardware requirements for each supported operating system are given in the
following table. All support statements assume that the stated systems can run the
required level of a compatible operating system and have enough storage for the
WebSphere Message Broker components that you install, and all prerequisite
products.

Table 1. Hardware requirements

Operating system Requirements1

AIX 64-bit IBM System p® systems
Any hardware from IBM or other vendors that
can run trademarked AIX systems2

HP-Itanium Itanium systems

HP-UX on PA-RISC Hewlett-Packard HP-9000 PA-RISC 2.0 processor servers

Linux on POWER 64-bit System i® and System p IBM POWER processor-based systems only

Linux on x86 IBM eserver System x® or equivalent Intel® servers3

Linux on x86-64 AMD64, EM64T, or compatible processor servers3

Linux on System z Any server capable of running one of the supported
Linux on System z releases

Solaris on SPARC Sun Microsystems SPARC processor servers

Solaris on x86-64 AMD64, EM64T, and compatible processor servers
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Table 1. Hardware requirements (continued)

Operating system Requirements1

Windows 32-bit Windows x86 technology-compatible PC hardware3

z/OS4 Any server capable of running one of the supported z/OS releases

Notes:

1. Always check the WebSphere Message Broker Requirements Web site
and the readme.html file for the latest information about supported
processors.
The readme.html file that is supplied on the product DVD or CD (for all
components) provides a minimum level of information, and directs you
to the online file on the product readmes Web page which is updated
regularly. Always use the online file to check that you have the latest
level of information.

2. You can use AIX systems only if they have passed a set of verification
tests for compliance with the AIX application binary and programming
interfaces.

3. The Message Broker Toolkit is supported on 32-bit systems only. It
requires a computer with an Intel Pentium® III processor (or higher)
that has a speed of at least 700 MHz. This specification is the minimum
supported level; for improved performance use a 2 GHz processor.
A minimum display resolution of at least 1024 x 768 is required for
some dialogs (for example, the Preferences dialog).

4. See the Program Directory for WebSphere Message Broker for z/OS or the
Program Directory for WebSphere Message Broker with Rules and Formatter
for z/OS for further details.

Memory and disk space requirements
Check the memory and disk space that is required for your installation.

Requirements for memory and disk space depend on the installation operating
system, and on the WebSphere Message Broker components that you are installing.

Distributed systems

v 512 MB of RAM is required to support runtime operations (1 MB equals
approximately 1 000 000 bytes).

v 512 MB of RAM is required to support Message Broker Toolkit
operations on Linux on x86, Linux on x86-64 or Windows. This
specification is the minimum supported level; for improved
performance, provide 1 GB (1 GB equals approximately 1 000 000 000
bytes).

v Disk space requirements are dependent on the components that you
install and the working space that is required by those components (for
example, for WebSphere MQ queues and persistent messages).
Check that your computer has at least the space shown in the table,
which provides guidance for both permanent product requirements and
temporary space. If you install just one or two of the runtime
components, the storage required is reduced by only a small amount.
Check that these requirements have not been updated in the latest
product readme file readme.html.
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If the installation directory and the temporary space are on the same
partition or drive, add the two figures to check that you have enough
space available. If you do not, increase the available storage or change
the location of either the temporary space or the installation directory.
The temporary files are deleted when installation is complete.
– On AIX, HP-UX, and Linux systems, the default temporary space

directory is /tmp.
– On Solaris systems, the default temporary space directory is /var/tmp.
– On Windows, the default temporary space directory is pointed to by

the TEMP system variable. On some systems, the variable TMP exists
and is used before TEMP, therefore you might must check or change
the setting of both these variables.

The installation wizard displays requirements for permanent space, but
not for temporary space. If the figure that the installation wizard
displays is greater than the figure shown in the following tables, check
that your computer has sufficient space before you continue with the
installation.

Component
Linux on
POWER Linux on x861 Linux on x86-64

Linux on
System z Windows1

WebSphere Message
Broker, Configuration
Manager, and User
Name Server

440 MB plus 300
MB temporary
space

440 MB plus 300
MB temporary
space

600 MB plus 300
MB temporary
space

440 MB plus 300
MB temporary
space

460 MB plus 300
MB temporary
space

Message Broker Toolkit Unavailable 1.9 GB plus 1.5
GB temporary
space

Unavailable Unavailable 1.9 GB plus 1.5
GB temporary
space

Note:

1. The space required for the Message Broker Toolkit includes
space for the shared resources directory and the package
group directory.

Component AIX HP-Itanium
HP-UX on
PA-RISC

Solaris on
SPARC

Solaris on
x86-64

WebSphere Message
Broker, Configuration
Manager, and User
Name Server

840 MB plus 300
MB temporary
space

900 MB plus 300
MB temporary
space

800 MB plus 300
MB temporary
space

860 MB plus 300
MB temporary
space

540 MB plus 300
MB temporary
space

Message Broker Toolkit Unavailable Unavailable Unavailable Unavailable Unavailable

v If you install one of the database products supplied with WebSphere
Message Broker, you need additional disk space:
– DB2 Enterprise Server requires approximately 300 MB. This

specification is for a Compact installation, which provides sufficient
function for WebSphere Message Broker; if you choose a Typical or
Custom installation, additional storage might be required.

– On Windows, ODBC (Open Database Connectivity) drivers for the
Derby database require approximately 105 MB.

v On computers on which you create a broker, approximately 10 MB is
required for the broker tables in your chosen database.

v If you create user databases that are accessed by message flows,
additional space is required on those computers.
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v If you intend to create more than one broker on any one computer, you
require additional memory and swap space. For example, you might
create more than one broker at different versions to complete migration.
Plan for 1 GB RAM and 1 GB of swap space for each broker, in addition
to the space and memory requirements of other applications.
You might must increase these figures if you deploy complex message
flows to the brokers, or if you process large messages (of many
megabytes), or complex messages that contain many different tags.

z/OS Details are given in Disk space requirements on z/OS. You must also check
for later updates to this information in the section about DASD storage
requirements in the Program Directory for WebSphere Message Broker for z/OS
or the Program Directory for WebSphere Message Broker with Rules and
Formatter for z/OS.

Communications
Your system must have communications hardware that supports the protocols that
product components can use.

Choose one or more of the following protocols:
v NetBIOS
v SNA LU 6.2
v SPX
v TCP/IP

Software requirements
View the operating system, database, and other software requirements.

This section provides information about requirements of WebSphere Message
Broker:
v “Support for 32-bit and 64-bit platforms”
v “Operating system requirements” on page 46
v “Additional software requirements” on page 56

Support for 32-bit and 64-bit platforms
WebSphere Message Broker operates in 32-bit mode, or 64-bit mode, or both, on
supported operating systems.

On operating systems where both modes are supported, 64-bit operation is the
default mode. If you create an execution group for a broker in a mode that is not
supported by its underlying hardware and software, it is created and operates in
the supported mode, although the workbench reports the mode that you specified.
For example, if you specify 64-bit mode on Windows, an execution group is
created, and you can deploy resources to it. It operates in 32-bit mode, even
though it is displayed as a 64-bit execution group.

The following table shows support for 32-bit and 64-bit mode. Changes since
Version 6.0 are summarized beneath the table. (64-bit mode is supported only by
Version 6.0 and later versions.) If support on your platform has changed, you
might must make additional changes to your configuration. See Migrating from
Version 6.0 products and Configuring WebSphere Message Broker for further
details.
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Although 64-bit editions of Windows operating systems are supported, they are
supported in toleration mode only; you cannot create 64-bit execution groups on
these systems.

Platform

WebSphere
Message Broker
internal
components and
commands

32-bit execution
groups

64-bit execution
groups

AIX1 64-bit Yes Yes

HP-Itanium 64-bit No Yes

HP-UX on PA-RISC1 64-bit Yes Yes

Linux on POWER1+2 64-bit No Yes

Linux on x86 32-bit Yes No

Linux on x86-64 64-bit Yes Yes

Linux on System z1+2 64-bit No Yes

Solaris on SPARC1 64-bit Yes Yes

Solaris on x86-641+2 64-bit No Yes

Windows 32-bit3 32-bit Yes No

z/OS 32-bit Yes No

Changes since Version 6.0:

1. On this platform, the broker internal components
(bipservice, bipbroker) operate in 64-bit mode; in
Version 6.0, the broker internal components
operated in 32-bit mode.

2. On this platform, you can no longer create or run
with 32-bit execution groups. Execution groups can
be only 64-bit mode.

3. The broker runs as a 32-bit application on both
32-bit and 64-bit editions of all supported Windows
operating systems.

Execution groups

You can create an execution group by using the workbench, the
mqsicreateexecutiongroup command, or the CMP.

If you do not specify the size of execution group that you require, the size that is
created depends on how you create it, and the version of the target broker to
which you deploy it. The following default values apply:
v If the target broker is Version 5.0, the execution group is always 32-bit.
v If the target broker is Version 6.0, the execution group is 32-bit except on

HP-Itanium, which supports 64-bit only.
v If the target broker is Version 6.1, the execution group is 64-bit except on those

platforms that support 32-bit only (Linux on x86, Windows, and z/OS).
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Table 2. Execution group default sizes

Workbench Command CMP API
32-bit only
platforms

32-bit and
64-bit
platforms

64-bit only
platforms

Default no options createExecutionGroup(name) 32-bit 64-bit 64-bit

32-bit -s createExecutionGroup(name, 32) 32-bit 32-bit 64-bit1

64-bit -l createExecutionGroup(name, 64) 32-bit2 64-bit 64-bit

Notes:

1. BIP2828 is generated.
2. BIP2827 is generated.

Operating system requirements
WebSphere Message Broker is supported on multiple operating systems.

Operating system software requirements are defined in the following table.

Operating system Requirements1

AIX v IBM AIX Version 5.3 (Technology Level 5 SP2)2

v IBM AIX Version 6.1

HP-Itanium v HP-UX 11i V2 (B.11.23) for Itanium (with HP-UX
recommended patches for Java 5.0)

v HP-UX 11i V3 (B.11.31) for Itanium

HP-UX on PA-RISC v HP-UX 11i V2 (B.11.23) (with HP-UX recommended
patches for Java 5.0)

v HP-UX 11i V3

Linux on POWER v Linux PowerPC® Red Hat Enterprise Linux V4.0 with
service level Update 23

v Linux PowerPC Red Hat Enterprise Linux V5.03

v Linux PowerPC SUSE Linux Enterprise Server (SLES)
9 RC5 or above

v Linux PowerPC SUSE Linux Enterprise Server (SLES)
10

Linux on x864
v Linux Intel Red Hat Enterprise Linux V4.0 with service

level Update 23

v Linux Intel Red Hat Enterprise Linux V5.03, 5

v Linux Intel SUSE Linux Enterprise Server (SLES) 9

v Linux Intel SUSE Linux Enterprise Server (SLES) 105

Linux on x86-64 v Linux Intel Red Hat Enterprise Linux V4.0 with service
level Update 23

v Linux Intel Red Hat Enterprise Linux V5.03

v Linux Intel SUSE Linux Enterprise Server (SLES) 9

v Linux Intel SUSE Linux Enterprise Server (SLES) 10
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Operating system Requirements1

Linux on System z v Linux zSeries® (64-bit) Red Hat Enterprise Linux V4.0
with service level Update 23

v Linux zSeries (64-bit) Red Hat Enterprise Linux V5.03

v Linux zSeries (64-bit) SUSE Linux Enterprise Server
(SLES) 9

v Linux zSeries (64-bit) SUSE Linux Enterprise Server
(SLES) 10

Solaris on SPARC v Sun Solaris Operating Environment 9 (with SunSolve
recommended Patch Cluster level)6

v Sun Solaris Operating Environment 10 (with SunSolve
recommended Patch Cluster level)

Solaris on x86-64 v Sun Solaris Operating Environment 10 (with SunSolve
recommended Patch Cluster level)7

Windows8
v Microsoft® Windows XP Professional (with service

level SP2)

v Microsoft Windows Vista Business Edition (with
service level SP1)

v Microsoft Windows Vista Enterprise Edition (with
service level SP1)

v Microsoft Windows Vista Ultimate Edition (with
service level SP1)

v Microsoft Windows Server 2003 Standard Edition9

v Microsoft Windows Server 2003 Enterprise Edition9

v Microsoft Windows Server 2003 R2 Standard Edition9

v Microsoft Windows Server 2003 R2 Enterprise Edition9

v Microsoft Windows Server 2008 Standard Edition

v Microsoft Windows Server 2008 Enterprise Edition

z/OS10
v IBM z/OS Version 1.7

v IBM SMP/E for z/OS Version 3.3 or later

Notes:

1. Always check the WebSphere Message Broker Requirements Web site
and the readme.html file for the latest information about supported
operating systems.
The readme.html file that is supplied on the product DVD or CD (for
all components) provides a minimum level of information, and directs
you to the online file on the product readmes Web page which is
updated regularly. Always use the online file to check that you have
the latest level of information.

2. WebSphere Message Broker requires the xlC runtime libraries at
Version 8 or above. If you do not have an xlC or xlC++ compiler at
this version installed, you must apply a PTF; information and
instructions are provided in this PTF support document.

3. If you install Red Hat Enterprise Linux V4 or V5, the SELinux feature
is not supported. SELinux is enabled by default; you must disable it
before you install the Message Broker Toolkit or a WebSphere Message
Broker runtime component.
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4. On Linux on x86 installations, you might require the following
additional packages that are available with the operating system:
v If you choose to use the graphical interface to install on SUSE Linux

Enterprise Server, install package compat (at version 2002.12.6.0 or
later). This package is not required for console or silent installations.

v If you want to use the Red Hat package manager (RPM), install
package rpm-build.

5. The Message Broker Toolkit is not supported on Red Hat Enterprise
Linux V5.0 or SUSE Linux Enterprise Server (SLES) 10.

6. If you install the broker or the Configuration Manager component on
Solaris 9 on Solaris on SPARC, the recommended Patch Cluster level
must include patches 111711-16 (32-bit) and 111712-16 (64-bit).

7. If you install the broker or the Configuration Manager component on
Solaris 10 on Solaris on x86-64, the recommended Patch Cluster level
must include patch 119964-08.
WebSphere Message Broker is supported only in the Global zone, or in
a whole root non-global zone, and must be installed separately in
each. To ensure a consistent environment, use the same approach to
installation for both WebSphere Message Broker and WebSphere MQ.
For further details about Solaris zones, see the WebSphere Message
Broker support statement.

8. Both 32-bit and 64-bit editions of all Windows operating systems are
supported, but all components operate run as 32-bit applications.
On WindowsVista and later operating systems, no features specific to
those operating systems are used by WebSphere Message Broker
components.

9. On Windows Server 2003 Standard and Enterprise Editions, you can
publish both the command console and the Message Broker Toolkit to
be accessed through Citrix XenApp (Presentation Server V4.0 and
V4.5).

10. z/OS Version 1.7 must be at RSU0609 or later (for the target system)
with PTFs for APARs PK34716 and PK34041
See the Program Directory for WebSphere Message Broker for z/OS or the
Program Directory for WebSphere Message Broker with Rules and Formatter
for z/OS for further details. In particular, review the information in
"Preventative Service Planning".

In all operating environments except z/OS, defect support is available for
virtualization environments where they relate to releases that are already
supported by WebSphere Message Broker. Unless stated elsewhere in the system
requirements, WebSphere Message Broker has not been tested in virtualization
environments. WebSphere Message Broker support is therefore unable to assist in
issues related to configuration and setup, or issues that are directly related to the
virtualization environment itself.

Supported databases
You must configure a database in which your broker can store operational and
state data. You can optionally configure databases to contain data that is accessed
by your message flows. Databases from IBM and other suppliers are supported at
specific versions on supported operating systems.

The support shown here, with the accompanying notes, indicate the minimum
levels of products for databases on each operating system, valid when the
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information center was published. However, database support might be enhanced
after the release is made available. For the latest information about database
support, visit the WebSphere Message Broker Requirements Web site.

You must create the broker database before you create the broker, and specify the
name of the database on the mqsicreatebroker command. The command creates
tables to hold the broker data; these tables are listed in “Database contents” on
page 55.

You can use the same database schema for all brokers that are at the same version,
if appropriate, even if you create the brokers on different computers. The broker
tables are created in a schema that is determined by the user ID that you specify
for the broker database connection, and the rows within the tables are qualified by
a unique identifier (UUID) for each broker. The schema user ID is set by -u
dataSourceUserId (if you specified this parameter on the mqsicreatebroker or
mqsichangebroker command), or by -i serviceUserId (if you did not specify the -u
parameter).

You can also create user databases to be accessed from message flows; support is
the same for broker and user databases except where stated. Some data types
supported by these databases are not supported by WebSphere Message Broker; for
details, see Data types of values from external sources.

In most environments, the broker and the database server must not be running on
the same operating system. For details about local and remote database use, and
the restrictions that apply, see “Database locations” on page 54.

WebSphere Message Broker supports both transactional (XA) and non-transactional
connections to databases. You can define an ODBC connection, or a JDBC type 4
connection, or both, to your database instances. XA support is referred to as a
globally coordinated message flow.

On a single broker, you can use ODBC XA, or JDBC XA, but not both. This
restriction applies to all supported platforms, and to all database servers for which
XA is supported.

The following sections give details of this support, and describe restrictions where
applicable:
v “ODBC support”
v “JDBC type 4 support” on page 53

ODBC support

The following table lists the supported database servers for each broker platform
for non-XA support. XA connections are supported by most of these servers: See
the notes following the table for details. You must define an ODBC connection to
your broker database.

Unless otherwise stated, the ODBC client code for the database is at the same
version and release as the server.
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Operating system DB21, 2,

3

Microsoft
SQL Server1

Oracle1, 4, 5 Sybase1 Informix1, 6

AIX 8.2

9.1

9.5

2000 SP3a7

2005 SP17

9i Release 2 Patch Set 4
(9.2.0.5, patch 3501955)

10g Release 1

10g Release 28

11g Release 1

12.5

15

Dynamic Server Version
9.4 with UC7 Fix Pack,
Client SDK Version 2.90
with UC4 Fix Pack

Dynamic Server Version
10.00 with FC5 Fix Pack,
Client SDK Version 2.90
with UC4 Fix Pack

HP-Itanium 8.2

9.1

9.5

2005 SP17 10g Release 2

11g Release 1

12.5 Dynamic Server Version
10.00 with FC5 Fix Pack,
Client SDK Version 2.90
with FC4R1 Fix Pack

HP-UX on PA-RISC 8.2

9.19

Not
supported

9i Release 2 Patch Set 4
(9.2.0.5, patch 3501955)

10g Release 1

10g Release 2

11g Release 1

12.5

15

Dynamic Server Version
9.4 with UC7 Fix Pack,
Client SDK Version 2.90
with HC4 Fix Pack

Dynamic Server Version
10.00 with FC5 Fix Pack,
Client SDK Version 2.90
with HC4 Fix Pack

Linux on POWER 8.2

9.1

9.5

Not
supported

9i Release 2 Patch Set 4
(9.2.0.5, patch 3501955)

10g Release 1

10g Release 2

12.5

15

Dynamic Server Version
9.4 with UC7 Fix Pack,
Client SDK Version 2.90
with UC4 Fix Pack

Dynamic Server Version
10.00 with FC5 Fix Pack,
Client SDK Version 2.90
with FC4 Fix Pack

Linux on x86 8.2

9.1

2000 SP3a7

2005 SP17

9i Release 2 Patch Set 4
(9.2.0.5, patch 3501955)

10g Release 1

10g Release 2

11g Release 1

12.5

15

Dynamic Server Version
9.4 with UC7 Fix Pack,
Client SDK Version 2.90
with UC3 Fix Pack

Dynamic Server Version
10.00 with UC5 Fix Pack,
Client SDK Version 2.90
with UC4 Fix Pack

Linux on x86-64 8.210

9.1

9.5

2000 SP3a7

2005 SP17

9i Release 2 Patch Set 4
(9.2.0.5, patch 3501955)

10g Release 1

10g Release 2

11g Release 1

12.5

15

Dynamic Server Version
9.4 with UC7 Fix Pack,
Client SDK Version 2.90
with UC3 Fix Pack

Dynamic Server Version
10.00 with FC5 Fix Pack,
Client SDK Version 2.90
with UC4 Fix Pack
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Operating system DB21, 2,

3

Microsoft
SQL Server1

Oracle1, 4, 5 Sybase1 Informix1, 6

Linux on System z 8.2

9.1

9.5

Not
supported

9i Release 2 Patch Set 4
(9.2.0.5, patch 3501955)

10g Release 1

10g Release 2

Not
supported

Dynamic Server Version
9.4 with UC7 Fix Pack,
Client SDK Version 2.90
with UC4 Fix Pack

Dynamic Server Version
10.00 with FC5 Fix Pack,
Client SDK Version 2.90
with FC4 Fix Pack

i5/OS® and
OS/400®11

V5R2

V5R3

V5R4

Not
supported

Not supported Not
supported

Not supported

Solaris on SPARC 8.212

9.1

9.5

2000 SP3a7

2005 SP17

9i Release 2 Patch Set 4
(9.2.0.5, patch 3501955)

10g Release 1

10g Release 2

11g Release 1

12.5

15

Dynamic Server Version
9.4 with UC7 Fix Pack,
Client SDK Version 2.90
with UC4 Fix Pack

Dynamic Server Version
10.00 with FC5 Fix Pack,
Client SDK V2.90 with
UCX8 Fix Pack

Solaris on x86-64 8.212

9.1

9.5

Not
supported

9i Release 2 Patch Set 4
(9.2.0.5, patch 3501955)

10g Release 1

10g Release 2

12.5

15

Not supported

Windows XP and
Server 200313

8.2

9.1

9.5

2000 SP3a

2005 SP1

9i Release 2 Patch Set 4
(9.2.0.5, patch 3501955)

10g Release 1

10g Release 2

11g Release 1

12.5

15

Dynamic Server Version
9.4 with TC7 Fix Pack,
Client SDK Version 2.90
with TC4 Fix Pack

Dynamic Server Version
10.00 with TC5 Fix Pack,
Client SDK Version 2.90
with TC4 Fix Pack

Windows Vista14 9.1.3

9.5

2005 SP2 10g Release 2

11g Release 1

12.5

15

Dynamic Server Version
10.00 with TC5 Fix Pack,
Client SDK Version 2.90
with TC4 Fix Pack

Windows Server
200814

9.1.3

9.5

2005 SP2 10g Release 2

11g Release 1

15.0.2 ESD5 Dynamic Server V10.00
with TC5 Fix Pack, Client
SDK Version 2.90 with
TC4 Fix Pack

z/OS 8.115

9.115

Not
supported

Not supported Not
supported

Not supported

Notes:

1. XA support:
Supported releases of DB2, Informix, Oracle, and Sybase can
participate as a resource manager in a distributed XA transaction, and
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can be coordinated by WebSphere MQ as the XA Transaction Manager,
unless otherwise stated in the following notes. On z/OS, all
transactions are coordinated by Recoverable Resource Services (RRS).
v Additional conditions for WebSphere MQ:

– WebSphere MQ Version 6.0.1.0 or later is required for globally
coordinated transaction (XA) support.

– On 64-bit platforms, WebSphere MQ (Version 6.0 and 7.0)
performs all transaction coordination in 64-bit mode. If you
require XA coordination, all data sources connected to DB2 from
message flows in both 32-bit and 64-bit execution groups must
connect to 64-bit DB2 instances.

– If you use WebSphere MQ Version 7 for XA coordination on
Windows, you must configure the queue manager to run under
the broker service user ID by specifying the -si option on the
strmqm command; for example, strmqm -si QM_name.

v Additional conditions for databases:
– If you deploy message flows that access databases, you can

define the message flows to be coordinated so that updates to
those databases are synchronized with updates to other resources.

– XA coordination for messages in the MRM domain on Windows
requires DB2 Version 8 Fix Pack 10 or later.

– ODBC drivers for Oracle and Sybase on all relevant systems, and
for SQL Server on Linux and UNIX systems, are supplied with
WebSphere Message Broker. Alternative drivers are not supported
on these systems. For other systems, and for other databases on
all systems, obtain these files from your database vendor.

2. Check the readme.html file for your product to check whether a fix
pack or other fix is required.
DB2 Version 8.2 is functionally equivalent to Version 8.1 Fix Pack 7.
DB2 Version 9.1 is supported at GA level except On Windows Vista
and later operating systems, where you must install DB2 Version 9.1
Fix Pack 3 or later. The version that is supplied with WebSphere
Message Broker includes Fix Pack 3 on all platforms (Fix Pack 3a on
Solaris).
If you define a connection to DB2 Version 8.2 from a broker that
operates in 64-bit mode, you must specify that you want to create a
64-bit database instance. If you use DB2 Version 9.1, a 64-bit instance is
the default instance created on 64-bit operating systems.

3. Automatic Client Reroute for DB2 is supported on all platforms.
4. If you install the Oracle Database Server on 32-bit systems, or on

mixed mode systems on which you plan to create 32-bit execution
groups, you must also install the Oracle Runtime Client.

5. On all Linux, UNIX, and Windows systems, you can use Oracle RAC
(Real Application Clusters) databases. If you want to run with XA
support, you must install Oracle 10g Release 2 patchset3 (10.2.0.4) or
above. For Oracle RAC XA and non-XA, failover support is limited to
the Connect-Time Failover feature only.

6. Informix is supported only as a user database accessed by message
flows; you cannot create a broker database as an Informix database.
Each broker system requires only the Client SDK; install the Dynamic
Server on the system on which you create databases.
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Large Objects (LOBs) are not supported.
7. On Linux and UNIX systems, you can remotely access an SQL Server

database on Windows by using a supplied wire protocol driver.
8. On AIX, Oracle 10g Release 2 requires the AIX fix for APAR IY89080.
9. If you use DB2 Version 9.1 or later on HP-UX on PA-RISC, you must

set the following environment variable, and export it in the broker
environment:
MQSI_SIGNAL_EXCLUSIONS=10

10. If you have installed Red Hat Enterprise Linux V4.0 and DB2 Version
8 Fix Pack 9 on Linux on x86-64, you must use a 32-bit database
instance. If you have a later release of DB2, you can use both 32-bit
and 64-bit database instances.

11. You can configure message flows to access DB2 databases on i5/OS
and OS/400 for user data. The message flows can run on all supported
broker platforms. You cannot create a broker database as a remote DB2
database on i5/OS or OS/400 from a broker platform. For further
details of these restrictions, and for information about the PTFs that
are required with DB2 on these operating systems, see “Database
locations” on page 54.

12. Solaris 10 on Solaris on SPARC requires DB2 Version 8 Fix Pack 9 or
later; Solaris 10 on Solaris on x86-64 requires DB2 Version 8 Fix Pack
11 or later.

13. For verification, evaluation, and test purposes on Windows XP and
Windows Server 2003 only, you can use the Derby database that is
embedded in the broker component with the ODBC drivers from DB2
Runtime Client V8.2. These drivers are included on the product media.
(Derby refers to the database product based on the Apache Derby
open source project from the Apache Software Foundation.) For a
production system, install and configure your chosen enterprise
database.

14. The Derby database is not supported On Windows Vista and later
operating systems.

15. On z/OS, DB2 is a mandatory requirement. You must create a unique
database for each broker.
v If you install DB2 Version 8.1, it must be at RSU0609 or later, and

you must install FMID JDB8817 (ODBC support) and PTFs for
APAR PK37248.

v If you install DB2 Version 9.1, you must install FMID JDB9917
(ODBC support) and PTFs for APAR PK41943.

See the Program Directory for WebSphere Message Broker for z/OS or the
Program Directory for WebSphere Message Broker with Rules and Formatter
for z/OS for further details. In particular, review the information in
"Preventive Service Planning".

JDBC type 4 support

For non-XA transactions, you can create a JDBC type 4 connection from a broker to
all the database servers that are listed in the ODBC support table. Connections are
supported from all broker platforms, including z/OS.

For XA connections, the following restrictions apply:
v On distributed platforms, only DB2 and Oracle are supported.
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v On z/OS, XA connections are not supported.
v For JDBC type 4 connections to DB2, you must install DB2 Version 9.1 Fix Pack 3

or later; support for DB2 Version 8 is not available.

JDBC type 4 drivers are not supplied with WebSphere Message Broker; obtain
these files from your database vendor. The following drivers are supported:
v IBM DB2 Driver for JDBC and SQLJ Version 9.1 and 9.5
v Microsoft SQL Server 2005 JDBC driver 1.1
v Oracle 10gR2 or 11gR1 JDBC Driver
v Sybase jConnect for JDBC 6.05
v IBM Informix JDBC 3.00.JC3

Database locations
The broker can access databases set up on the local computer or on a remote
server, subject to restrictions.

A broker domain requires databases to support its brokers. In addition, your
brokers can host message flows that access user databases. (The Configuration
Manager and the User Name Server have no requirement for database access.)
v You can use a local or remote database for a broker database, subject to the

following restrictions:
– You cannot create a remote broker database on i5/OS or OS/400.
– If your broker is running on a distributed system, including Linux on System

z, you cannot create the database on z/OS.
v You can use a local or remote database for user data, subject to the following

restrictions:

Databases on i5/OS and OS/400

– You can use only DB2 (UDB) on iSeries® (System i) under OS/400 or
i5/OS.

– You must install OS/400 V5R2, or i5/OS V5R3 or V5R4.
– On Linux, UNIX, and Windows, you can connect using DB2

Connect™. On Windows only, you can also use iSeries Access for
Windows.

– You cannot define globally coordinated (XA) transactions.
– You cannot configure message flows that include Rules and Formatter

Extension nodes to access a database on i5/OS or OS/400.
– You can call stored procedures only if access to the remote database is

provided by DB2 Connect.

Databases on z/OS

– You can use only DB2 (UDB) on z/OS.
– You must use DB2 Connect on Linux, UNIX, and Windows.
– You cannot configure message flows that include Rules and Formatter

Extension nodes to access a database on z/OS.

For further details, see the Program Directory for WebSphere Message Broker
for z/OS or the Program Directory for WebSphere Message Broker with Rules
and Formatter for z/OS.

WebSphere Information Integrator databases

– You can configure message flows on all distributed systems to access
user data in WebSphere Information Integrator for Linux, UNIX, and
Windows Version 8.2.
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You can also configure message flows to access user data, by using
JDBC only, in WebSphere Information Integrator Classic Federation
(IICF) for z/OS Version 8.2, on operating systems for which the
WebSphere IICF client code is provided.

– You can configure message flows on z/OS brokers to access user data,
by using JDBC only, in WebSphere Information Integrator Classic
Federation for z/OS Version 8.2. This support provides connectivity
with the following z/OS data sources:
- IMS™

- VSAM
- ISAM
- Sequential files
- CA-IDMS
- CA-Datacom
- Software AG ADABAS
- DB2
Brokers can connect directly to WebSphere Information Integrator
Classic Federation for z/OS Version 8.2 by JDBC only.
Brokers can connect indirectly to WebSphere Information Integrator
Classic Federation for z/OS Version 8.2 through an intermediate DB2
system on z/OS. If you use this configuration, only an ODBC CAF
(Call Attachment Facility) connection is supported between the broker
and DB2; this connection therefore does not support two-phase
commit.
You must configure all broker ODBC data resources as either CAF or
RRSAF (Recoverable Resource Services attachment facility). If you use
CAF, database operations are not coordinated by RRS; this restriction
applies to updates to the broker database and to user data.

v If you use a remote database, you must configure the ODBC connection to the
database correctly. Refer to the documentation for the database product that you
are using for further information.

See the documentation for the database product that you are using with
WebSphere Message Broker to determine the best options for your specific
environment and requirements, and information about how to configure remote
database access.

Database contents
WebSphere Message Broker stores configuration and resource information in
databases to retain the information and ensure its security and integrity. Each
broker creates and maintains information in tables created for that purpose.

When you create a broker, the mqsicreatebroker command creates a number of
database tables within the database that you specify in the command. The database
schema is created, if it does not exist, based on the user ID you specify on the
command. The tables are also created if they do not exist.

You can specify parameters that create a different database schema for every
broker, or share a database schema between brokers. If you create further brokers
that specify the same database schema, new rows are created for each broker.
Every row that is created in the table is qualified by a unique identifier (UUID) for
each broker, therefore each row is unique to a single broker.

The following table shows the database tables that are created by the
mqsicreatebroker command in the broker database schema.
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Table name Description

BACLENTRIES ACL entries

BCLIENTUSER Maps client identifiers to durable subscriptions

BGROUPNAME Publish/subscribe principals: groups

BMQEPUBDEST Contains list of WebSphere MQ Everyplace® queues on which messages can
be placed

BMQEPUBMSGIN Holds persistent WebSphere MQ Everyplace publish/subscribe messages
waiting to be processed by the broker

BMQEPUBMSGOUT Holds persistent WebSphere MQ Everyplace publish/subscribe to be placed
on an WebSphere MQ Everyplace queue

BMQESTDMSGIN Holds persistent WebSphere MQ Everyplace non-publish/subscribe
messages waiting to be processed by the broker

BMQESTDMSGOUT Holds persistent messages to be sent to WebSphere MQ Everyplace
destinations

BMQPSTOPOLOGY Publish/subscribe neighbor information

BMULTICASTTOPICS Multicast topics records

BNBRCONNECTIONS Inter-broker neighbor connection information

BPUBLISHERS Registered publishers

BRETAINEDPUBS Retained publications

BRMINFO Registered resource managers

BRMPHYSICALRES Physical resources

BRMRTDDEPINFO Runtime dictionary dependency values

BRMRTDINFO Registered runtime dictionaries

BRMWFDINFO Registered wire format descriptors

BROKERAA Broker process details to support recovery

BROKERAAEG Execution group details to support recovery

BROKERRESOURCES Broker resources

BSCADADEST Contains list of SCADA clients to which messages can be sent

BSCADAMSGIN Holds persistent SCADA messages waiting to be processed by the broker

BSCADAMSGOUT Holds persistent messages to be sent to SCADA destinations

BSUBSCRIPTIONS Durable subscription information

BTOPOLOGY Inter-broker neighbor information

BUSERCONTEXT Maps client identifiers to context information

BUSERMEMBERSHIP Publish/subscribe principals: membership

BUSERNAME Publish/subscribe principals: users

Additional software requirements
WebSphere Message Broker requires additional software products to run
successfully.
v “WebSphere MQ” on page 57
v “Microsoft Visual C++ ” on page 58
v Java runtime environment
v “Installation Manager” on page 59
v “XML Toolkit” on page 59
v “Browsers” on page 59
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WebSphere MQ

All WebSphere Message Broker components require WebSphere MQ at the
minimum supported level shown in the table.

WebSphere MQ Version 6.0 (with tailored terms and conditions for use with
WebSphere Message Broker) is supplied on DVD on Linux on x86 and Windows
only, and on CD on all platforms. If you have a previous version of
WebSphere MQ, you can use the supplied CDs or DVD to upgrade your current
installation.

WebSphere MQ Version 7 is supported on all operating systems, but is not
supplied with WebSphere Message Broker. If you want to install this version, you
must obtain it yourself.

All runtime components (broker, Configuration Manager, and User Name Server)
require a WebSphere MQ queue manager. Each component of the same type must
have a dedicated local queue manager. More than one broker cannot share a single
queue manager; this restriction also applies to Configuration Manager and to User
Name Server components. Components of different types can share a queue
manager; for example, a broker and a Configuration Manager on a single computer
can share a queue manager.

Operating system Requirements

Windows Vista and Windows Server 20081 WebSphere MQ Version 7.0 (or later)2, 3, 4

All other distributed systems1 WebSphere MQ Version 6.0 (or later)2, 4, 5

z/OS6 WebSphere MQ Version 6.0.0 (or later) with MQ Java Classes
feature5

Notes:

1. WebSphere MQ is not required on Linux on x86 or Windows systems
on which you install only the Message Broker Toolkit.
If you want to configure an SSL connection between the Message Broker
Toolkit and the Configuration Manager, you must have an SSL
certificate manager installed on the computer on which you have
installed the Message Broker Toolkit. If you choose to use
WebSphere MQ to provide SSL management, install either the Client or
the Server; both components include IBM Key Management tools.

2. If you choose to install WebSphere MQ Version 7.0, you can configure
the broker so that all publish/subscribe application messages and
operations are handled by the queue manager.

3. When you have installed WebSphere MQ Version 7.0 on Windows Vista
or Windows Server 2008, you must apply a fix pack that includes APAR
IC57915.

4. The minimum set of components that you must install are the server
and Java Messaging components.
You can install WebSphere MQ before or after you have installed
WebSphere Message Broker.
If you have already installed WebSphere MQ Version 6.0 or Version 7.0,
check that your installation includes the Java Messaging component;
add it from the WebSphere MQ media if it is not installed.
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On Windows XP or Windows Server 2003 systems, if you choose to
install WebSphere MQ Version 6.0 from the Windows Launchpad,
Express® installation installs all required components for you. If you use
Advanced installation, select a custom installation and include the
server and Java Messaging components.
If you start the WebSphere MQ Version 6.0 installation program directly
on any platform, including Windows, select a custom installation and
include the server and Java Messaging components.
If you want to use the WebSphere MQ Explorer, the graphical interface
that is available on Linux on x86 and Windows only, install the
WebSphere Eclipse Platform Version 3.0.1 (Version 3.3 on Windows
Vista and Windows Server 2008) and the WebSphere MQ Explorer
components.
Other WebSphere MQ components are optional.

5. Check the availability of WebSphere MQ Version 6.0 on your operating
system; exact GA versions vary on different platforms.
Some specific broker functions might require later levels of
WebSphere MQ:
v Globally-coordinated (XA) transactions are supported only by

WebSphere MQ V6.0.1.0 or later.
v If you develop message flows that use WebSphere MQ Real-time

Transport with Multicast PGM support, you must apply APAR
IC47032 and USERMOD ANPGM01 on WebSphere MQ Version 6.0.

6. On z/OS, WebSphere MQ is a mandatory requirement and must be
installed before you install WebSphere Message Broker. WebSphere MQ
must be at RSU0609 or later, and you must install FMID JMS6008 (MQ
connectivity) and PTFs for APARs PK53810 and PK55665
If you have installed WebSphere MQ Version 7.0, you must apply the
PTFs for the following APARs: PK64703, PK68828, PK68831, PK69317,
PK70759, and PK73269.
See the Program Directory for WebSphere Message Broker for z/OS or the
Program Directory for WebSphere Message Broker with Rules and Formatter
for z/OS for further details about required levels of WebSphere MQ.

For details of WebSphere MQ products and supported versions, see the WebSphere
MQ product information Web site.

Microsoft Visual C++

On Windows XP and Windows Server 2003 only, Microsoft Visual C++ Runtime V8
SP1 is required. It is supplied with the product media in US English only. If you
use the Launchpad Express installation to install WebSphere Message Broker
components, it is installed for you. If you use another method, you must install it
yourself.

If you want to install a multicultural version of this product, which displays a
translated installation interface and product license agreement, you must download
the version that you want before installing.

For further information about how to install this product, see the “Installation
Guide” on page 3.
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JRE

A Java runtime environment (JRE) is required on all platforms:
v On distributed platforms, Java Runtime Environment (JRE) Version 5 SR5 is

embedded in product components.
v On z/OS, you must acquire and install a JRE which must be Version 5 (SR5 or a

later service release).
See the Program Directory for WebSphere Message Broker for z/OS or the Program
Directory for WebSphere Message Broker with Rules and Formatter for z/OS for
further details and the latest information. In particular, review the information in
"Preventative Service Planning".

WebSphere Message Broker supports all JMS providers that conform to the Java
Message Service Specification, version 1.1, and requires the minimum JRE levels
stated here. You must consider both these factors when you select a JMS provider
whose client is embedded in the broker.

Installation Manager

All Rational® products at Version 7.0 or later are installed by IBM Installation
Manager, which also controls management, updates, licensing, and uninstallation.
The Message Broker Toolkit includes some Rational product components, and
therefore includes and uses Installation Manager.

For further information about Installation Manager and the Message Broker
Toolkit, see the “Installation Guide” on page 3.

XML Toolkit

For z/OS only, you must install the IBM XML Toolkit for z/OS, Version 1.9.

See the Program Directory for WebSphere Message Broker for z/OS or the Program
Directory for WebSphere Message Broker with Rules and Formatter for z/OS for further
details and the latest information. In particular, review the information in
"Preventative Service Planning".

Browsers

For best results when viewing the information center from the Message Broker
Toolkit, use Mozilla 1.4.2 (or later) on Linux on x86 and Linux on x86-64.

On Windows, an embedded browser is launched to view the information center.

Some Linux on x86 and Linux on x86-64 offerings do not install Mozilla by default.
If you plan to install the Message Broker Toolkit on your Linux on x86 or Linux on
x86-64 system, check that a supported version of Mozilla is already installed. If
not, install Mozilla from your Linux on x86 or Linux on x86-64 operating system
media.

Optional software support
The products listed here are not required, but might be useful. Except where
stated, these products are not supplied with WebSphere Message Broker.
v “EIS client libraries” on page 60
v “WebSphere Adapters” on page 60
v “WebSphere MQ Everyplace” on page 60
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v “Tivoli License Manager”
v “Security providers”
v “JMS providers”
v “Compilers”
v “Adobe Flash Player” on page 61
v Citrix XenApp
v “WebSphere Service Registry and Repository” on page 61

EIS client libraries

If you plan to use WebSphere Adapters on any supported operating system, you
must obtain the appropriate Enterprise Information System (EIS) client libraries
from the relevant EIS vendor (for example, PeopleSoft, Siebel, or SAP). The client
libraries are required to complete connections between Adapters nodes and the
EIS; install them on each computer on which you run a broker that hosts message
flows that include Adapters nodes.

WebSphere Adapters

WebSphere Message Broker Version 6.1 supports WebSphere Adapters Version 6.1.
For more information about the hardware and software requirements of WebSphere
Adapters, see Supported software for WebSphere Adapters.

WebSphere MQ Everyplace

WebSphere MQ Everyplace supports messaging to, from, and between pervasive
devices, including handheld devices such as mobile phones and PDAs.

WebSphere MQ Everyplace Version 2.0.2.0 is supplied with WebSphere Message
Broker, but is not supported on Windows Vista or Windows Server 2008.

Tivoli License Manager

To monitor the use of software products including WebSphere Message Broker,
install IBM Tivoli License Manager Version 2.1.

Security providers

The message flow security manager interacts with external security providers:
v Lightweight Directory Access Protocol (LDAP) provides authentication and

authorization services. You must use an LDAP server that is LDAP Version 3
compliant.

v Tivoli Federated Identity Manager (TFIM) V6.1 provides authentication,
mapping, and authorization services.

JMS providers

The JMSInput and JMSOutput nodes are compatible with, and work with, any JMS
provider that conforms to the Java Message Service Specification, version 1.1.

Compilers

If you develop user-defined extensions in C or Java, you need the appropriate
supported software:

C
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AIX AIX
IBM XL C/C++ for AIX Version 8.0

HP�UX HP-UX on PA-RISC
HP aC++ Version A 03.73 or later

HP�UX HP-Itanium
HP aC++ Version A 06.12 or later

Linux Linux on POWER
GNU gcc, Version 3.3 or later

Linux Linux on x86
GNU gcc, Version 3.3 or later

Linux Linux on x86-64
GNU gcc, Version 3.3 or later

Linux Linux on System z
GNU gcc, Version 4.1 or later

Solaris Solaris on SPARC
Sun Studio 11

Solaris Solaris on x86-64
Sun Studio 11

Windows Windows
Microsoft Visual Studio 2005 (SP1)

If you use other versions of Microsoft Visual Studio, you must
install the relevant Microsoft C Run Time (CRT) libraries including
the appropriate Microsoft manifest files together with your
manifest files and .dll files.

See the Microsoft Visual Studio documentation for details on
redistribution of the CRT.

z/OS z/OS
IBM z/OS C/C++, for z/OS Version 1.5 or later

Java Version 5 (also known as Java 1.5) SR5 is supported on all operating
systems. An SDK is included on distributed systems, and is installed in the
install_dir\jre15 directory. On z/OS, you must install your required
level of JRE. For further details, see “Additional software requirements” on
page 56.

Adobe Flash Player

If you want to start the Quick Tour from the information center in the Message
Broker Toolkit, you must install Adobe Flash Player Version 6.0 or later. You can
freely download from the Adobe Web site an Adobe Flash Player plug-in for the
Web browsers that are supported by the Message Broker Toolkit.

WebSphere Service Registry and Repository

WebSphere Service Registry and Repository provides a central repository of
documents that describe services, service interfaces, and associated policies.
WebSphere Message Broker V6.1.0.2 and later supports WebSphere Service Registry
and Repository V6.1; previous versions of WSRR are not supported.
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System requirements for Citrix XenApp
This topic gives information about licensing issues, and the software and hardware
that you need to use WebSphere Message Broker in a Citrix XenApp environment.

Operating system

The required operating system is Windows 2003 Server. Client versions of
Windows, such as Windows XP, cannot be used because Citrix XenApp requires
Terminal Server, which is not available on client versions of Windows.

The recommended version of Windows Server 2003 is Enterprise Edition. You can
also use Windows Server 2003 Standard Edition, but you might need to reduce the
maximum heap size for the Java virtual machine that is used by the Message
Broker Toolkit.

Software prerequisites

Citrix XenApp (previously known as Citrix Presentation Server 4.0 or 4.5) and its
prerequisites must be installed on the Windows 2003 server.

Hardware prerequisites

The server must have enough CPU, RAM, disk space, and network bandwidth for
each concurrent user. Performance depends on the tasks that are being performed,
and on the hardware, software and networking setup. As a guide, the server
should have a minimum of 1 GB of RAM per concurrent user and at least 4 GB of
RAM in total. If the tasks require frequent disk access, it should help performance
to have a separate physical disk for each user so that they do not slow each other
down.

Licensing

Any number of users can use the Message Broker Toolkit through Citrix, provided
they all connect only to a Message Broker that has a valid license.

General industry standards supported by WebSphere Message Broker
WebSphere Message Broker supports general industry standards that are associated
with message processing.

Supported standards

The following table details the general standards and versions supported.

Standard Supported releases in Version 6.1

XSD 1.0

WSDL 1.1

SOAP 1.1, 1.2

XSLT 1.0

WS-Security 1.0

WS-Addressing 1.0 (Final 2005/08), Submission 2004/08

Java 1.5 (Version 5)

62 Managing your Installation



Installation and uninstallation interfaces
You can use different interfaces for installation and uninstallation of runtime
components and the Message Broker Toolkit.

When you install or uninstall the runtime components, you can choose a graphical,
console, or silent interface. These options are described in “How to install and
uninstall runtime components.”

When you install or uninstall the Message Broker Toolkit, you can choose a
graphical or silent interface. These options are described in “How to install and
uninstall the Message Broker Toolkit” on page 67.

Examples of commands in the topics in this section use installer and uninstaller for
the names of the installation or uninstall wizard. Substitute the correct names for
the platform on which you are using the wizard. Unless otherwise specified, you
can use the examples for uninstalling components, or applying service; the same
format is used for all three operations.

How to install and uninstall runtime components
Install and uninstall runtime components by using one of three interfaces.
v “Graphical interface”
v “Console interface” on page 64
v “Silent interface” on page 64

Each interface has different advantages, which are discussed in the appropriate
sections. When you have chosen the interface that you want to use:
v Check that your user ID has the correct authority to complete this task; see

'Installation and uninstallation authorization' in the information center for
details.

v Follow the installation instructions in the “Installation Guide” on page 3 (for a
new installation), in “Installing” on page 3 (to install service to existing
components), or in “Uninstalling” on page 29 (for product components and
service).

Graphical interface

The installation and uninstallation wizards open a graphical interface if you start
them with no options (the default interface). The wizards guide you through the
installation or uninstallation process with a series of pages that present options and
defaults. You can accept the default values, or change them to suit your
environment and requirements.

The graphical interface provides the highest level of information and guidance. Use
this interface when you are unfamiliar with the product, or to monitor progress.

If you click Cancel before the Install Progress or Uninstall Progress panel appears,
you can exit the setup. If you choose to exit, your system returns to its state that it
was in before the wizard was started. However, if you cancel the installation
wizard after installation or uninstallation has completed, and the final summary
panel is displayed, your system is not restored to its previous state: the wizard
stops immediately. If you want to remove any program that has been installed,
invoke the uninstallation wizard.
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When you use the wizards, you might have to wait a few seconds to move to the
next panel after clicking Next. Progress is not always displayed on all panels. If
you click Next twice, you might skip an entire panel. To ensure the installer or
uninstaller is progressing, monitor your processor usage, which increases greatly
during both installation and uninstallation.

Console interface

The console interface is a character-based interface with which you interact in a
command window. It presents the same options as the graphical interface.

Use the console interface if you want a command-line or text interface rather than
a graphical interface. This interface is suitable for users who use only the keyboard
to choose values and navigate through installation, and those with screen reader
software such as JAWS.

Invoke the installer using the following command. Use the same format for the
uninstaller.
installer -console

Use these prompts to navigate through the wizard:
v 1 Move to the next panel
v 2 Return to the previous panel
v 3 Cancel and terminate the wizard
v 4 Redisplay the current screen

The default option is always displayed within brackets, for example [1]. If this
default option is the correct choice, press Enter to continue.

Silent interface

Use the silent interface for automated installation or uninstallation over a large
number of identical systems. If you start a silent installation or uninstallation, the
wizard runs without any interaction. Using this interface, the process is completed
with default options, or according to a predefined set of options. The silent
interface does not provide any feedback to the caller, therefore you must view the
log to check whether the action was successful.

If you use the silent interface to uninstall runtime components, the wizard always
uninstalls components from the last known Version 6.1 installation location (that is,
the most recent installation), regardless of the location of the uninstallation wizard
that you invoke. To remove components from an earlier Version 6.1 installation,
use the console or graphical interface.

You can perform a silent installation in the following ways:
v With default options:

The installation wizard performs the following actions:
– Checks that prerequisite software is installed
– Installs to the default directory
– Installs all selectable features
Because the installation wizard checks for prerequisite software using the silent
interface, the program fails if the prerequisite software is not already installed.
You can override this check if you use a response file (see “Using response files
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with runtime components”), or include the appropriate parameter with a
non-default value on the command invocation.
The uninstallation wizard performs the following actions:
– Removes all selectable features
To run the wizard with default options, specify the -silent option on the
command:
installer -silent

v With one or more non-default options:
If you want the wizard to use non-default values for one or more options,
specify non-default options either on the command invocation, or in a response
file, as described in “Using response files with runtime components.”
A sample response file is provided in the sample-scripts directory of the root
CD directory. This file includes detailed information about the options that you
can change, and the values that you must enter to change them. Tailor this file
to match your requirements, or generate a new response file.
To run a tailored silent installation using a response file called response1.txt,
specify the -silent -G licenseAccepted=true options and the file name on the
command:
installer -silent -options response1.txt

Using response files with runtime components
Use a response file to define the behavior of an installation or uninstallation
wizard running the silent interface.

A response file is a text file that contains options that define the choices that the
wizard makes. You can use response files to install or uninstall runtime
components, or to apply service updates, using non-default values.
v “Editing the sample response files”
v “Recording a response file” on page 66
v “Generating response files” on page 66
v “Calling response files in commands” on page 67

Editing the sample response files:

Sample response files are supplied. On Linux and UNIX systems, the files are
/sample-scripts/install.opt and /sample-scripts/uninstall.opt. On Windows,
the files are \sample-scripts\install.opt and \sample-scripts\uninstall.opt.
The sample response files include detailed information about the options that you
can change, and the values that you can enter to change them. You can tailor these
files to match your requirements.

A number sign (#) at the start of a line denotes a comment. Remove the comment
character to enable the line.

You must remove the comment character at the start of the following line. If you
do not do this, your other options are ignored.
# -W setupTypes.selectedSetypTypeId=

Some examples of how you can modify the installation response file follow:
v Choose a custom installation (typical is the default option):

-W setupTypes.selectedSetupTypeId=custom

v Install to a non-default directory.
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Find the following line, remove the number signs, and insert your chosen
installation directory:
### -P installLocation=new_location

v Choose which components to install.
For example, to exclude the Configuration Manager, find this line in the
response file:
# -P configManagerFeature.active=true

Change the line to read:
-P configManagerFeature.active=false

v Specify whether the program is to check for prerequisite software.
Add one or more of the following lines to the file to instruct the installation
wizard to ignore the check for specific software:
# don't check for WebSphere MQ
-P mqPrerequisite.active=false

# don't check for Java Messaging
-P javaMessagingPrerequisite.active=false

Recording a response file:

Use the following command to record a response file:
installer -options-record responsefile

where responsefile is the full path and name of your chosen response file. On
Windows, surround the path and name with quotation marks if it contains spaces
("response file"). Create this file in a directory different from the one in which the
product is installed.

The installation wizard starts its graphical interface and records your responses as
it progresses. When installation is complete, the response file contains all the
choices that you have made during installation.

If you want to record a response file during a console installation, use the
following command:
installer -options-record responsefile -console

Generating response files:

Use the following command to generate a template installation response file. The
wizard does not perform installation or uninstallation when you start it with these
options:
installer -options-template responsefile

where responsefile is the full path and name of your chosen response file. On
Windows, surround the path and name with quotation marks if it contains spaces.
If you are uninstalling, create the response file in another directory to ensure that it
is not deleted as part of the uninstallation.

The generated template response file contains full instructions on how to edit it to
specify your required options.

To generate a response file during a console installation, use the following
command:
installer -options-template responsefile -console
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Calling response files in commands:

Use the following command to run the silent interface with a response file:
installer -options responsefile -silent

where responsefile is the full path and name of your chosen response file. On
Windows, surround the path and name with quotation marks if it contains spaces.

The wizard runs, taking its input from the response file.

How to install and uninstall the Message Broker Toolkit
Install and uninstall the Message Broker Toolkit by using one of two interfaces.
v “Graphical interface”
v “Silent interface”

Each interface has different advantages, which are explained in the appropriate
sections. When you have chosen the interface that you want to use:
v Check that your user ID has the correct authority to complete this task; see

'Installation and uninstallation authorization' in the information center for
details.

v Follow the installation instructions in the “Installation Guide” on page 3 (for a
new installation), in “Installing” on page 3 (to install service to existing
components), or in “Uninstalling” on page 29 (for product components and
service).

Graphical interface

The installation and uninstallation wizards open a graphical interface if you start
them with no options (the default interface). The wizards guide you through the
installation or uninstallation process with a series of pages that present options and
defaults. You can accept the default values, or change them to suit your
environment and requirements.

The graphical interface provides the highest level of information and guidance. Use
this interface when you are unfamiliar with the product, or to monitor progress.

If you click Cancel before the Install Progress or Uninstall Progress panel appears,
you can exit the setup. If you choose to exit, your system returns to its state that it
was in before the wizard was started. However, if you cancel the installation
wizard after installation or uninstallation has completed, and the final summary
panel is displayed, your system is not restored to its previous state: the wizard
stops immediately. If you want to remove any program that has been installed,
start the uninstallation wizard.

When you use the wizards, you might must wait a few seconds to move to the
next panel after clicking Next. Progress is not always displayed on all panels. If
you click Next twice, you might skip an entire panel. To ensure that the installer or
uninstaller is progressing, you can monitor your processor usage, which increases
greatly during both installation and uninstallation.

Silent interface

Use the silent interface for automated installations over many identical systems. If
you start a silent installation or uninstallation, the wizard runs without any
interaction; the process is completed with default options, or according to a
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predefined set of options. The silent interface does not provide any feedback to the
caller; therefore, you must check the log to determine whether the action was
successful.

You can run a silent installation with default settings, or with one or more
non-default values:
v With default settings, the installation wizard performs the following actions:

– Installs to the default directories
– Installs all supported locales
To run a default silent installation, enter the following command. Locate the
installation wizard in the /Message_Broker_Toolkit_V7/disk1/IBMInstallation
Manager directory of the local or remote DVD, or the network drive. If IBM
Installation Manager is not already installed, it is installed before the Message
Broker Toolkit is installed.

Linux Linux on x86
./install -nosplash --launcher.suppressErrors -silent -input mbtoolkit-silent.xml

Windows Windows
install.exe -nosplash --launcher.suppressErrors -silent -input mbtoolkit-silent.xml

v With one or more non-default settings, the wizard applies the options that you
specify in a response file to determine what actions to take.
If you want the wizard to use non-default values for one or more options,
specify a recorded response file, as described in “Using response files with the
Message Broker Toolkit.”

Using response files with the Message Broker Toolkit
Specify a response file to define the behavior of the installation or uninstallation
wizard.

You can use response files to install or uninstall the Message Broker Toolkit, or to
apply service updates.
v “Editing the sample response files”
v “Recording a response file”
v “Calling response files in commands” on page 69

Editing the sample response files:

A sample response file mbtoolkit-silent.xml is supplied on Linux on x86 and
Windows. The files assume that IBM Installation Manager has not yet been
installed, and sets options to install both Installation Manager and the Message
Broker Toolkit in the default locations.

Although you can tailor these files to match your requirements, for example by
changing the installation locations, the record option on a graphical installation or
uninstallation is preferable. If you use the record option, you do not have to
modify the file content, which is complex because the files handle multiple
installations, directories, and options.

Recording a response file:

Use the following command to record a response file:
v On Linux on x86:

./install -record response.xml
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v On Windows:
install.exe -record response.xml

where response.xml is the full path and name of your chosen response file. On
Windows, surround the path and name with quotation marks if it contains spaces.
Create this file in a directory different from the one in which the product is
installed.

The installation wizard opens its graphical interface, and requires your input as it
progresses. Your responses are recorded during installation. When installation is
complete, the response file contains all the choices that you have made during
installation.

Calling response files in commands:

Use the following command to run the installation wizard with the silent interface
and a recorded response file:
v On Linux on x86:

./install -nosplash --launcher.suppressErrors -silent -input response.xml

v On Windows:
install.exe -nosplash --launcher.suppressErrors -silent -input response.xml

where response.xml is the full path and name of the response file you recorded. On
Windows, surround the path and name with quotation marks if it contains spaces.

The wizard runs, taking its input from the response file.

Installation and uninstallation authorization
Check the authorization requirements for the user ID that you use to install or
uninstall runtime components and the Message Broker Toolkit.

Check that your user ID has the following authority to complete installation or
uninstallation tasks:
v On AIX systems, you must log in as root.
v On Linux and other UNIX systems, your user ID must have root authority to

complete installation. Follow your local security guidelines to acquire root
authority; either log in as root, or log in as another user and become root.

v On all Windows operating systems and editions, your user ID must be a
member of the Administrators group.

v On z/OS systems, your user ID must be no more than eight characters in length.
It must also have suitable privileges to install in your environment with SMP/E.
Use a supported external security manager, for example RACF® or ACF2, to
grant the required privileges. Your user ID must have a valid OMVS segment,
because the product installs into the file system paths specified during the
SMP/E APPLY processing

Multicultural support

The user interface and message catalogs are provided in the following languages
on distributed systems:
v Brazilian Portuguese
v French
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v German
v Italian
v Japanese
v Korean
v Simplified Chinese
v Spanish
v Traditional Chinese
v US English

The message catalogs are provided in the following languages on z/OS:
v Japanese
v Simplified Chinese
v US English

The messages written to the z/OS operator console (which are a subset of the
messages written to the syslog) are in US English only, and are written in mixed
case or in uppercase depending on your chosen system configuration.

WebSphere Message Broker provides a selection of message catalogs that are used
by the product components to report any problems that occur. Products that are
used in conjunction with WebSphere Message Broker might cause WebSphere
Message Broker to report errors using its message catalogs, or might report
problems using their own techniques.

You must refer to the documentation supplied with any other products that you
use to determine the process they employ. In particular, you must check the
documentation supplied by the databases that you use and documentation
provided with any user-defined node or parser that you integrate into the
WebSphere Message Broker environment.

You can install WebSphere Message Broker and WebSphere MQ in any supported
language; all language versions for each product are compatible with all language
versions for the other product. All languages for the WebSphere MQ messaging
products are included on the WebSphere MQ server CD supplied with WebSphere
Message Broker.

All messages generated for internal inter-component message exchange (for
example, deployed configuration messages and log files for mqsireadlog) are
generated in code page 1208 (utf-8).

Locales
Message support is provided in a number of locales.

WebSphere Message Broker supports at least the following locales:

Windows AIX Solaris HP-UX1 Linux2 z/OS

English (United
States)

en_US en_US en_US.iso88591,
en_US.roman8

en_US En_US.IBM-1047,
En_US.IBM-037

German (Standard) de_DE, De_DE de de_DE.ISO88591,
de_DE.roman8

de_DE not supported

Spanish (Modern
Sort)

es_ES, Es_ES es es_ES.ISO88591,
es_ES.roman8

es_ES not supported

French (Standard) fr_FR, Fr_FR fr fr_FR.ISO88591,
fr_FR.roman8

fr_FR not supported
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Windows AIX Solaris HP-UX1 Linux2 z/OS

Italian (Standard) it_IT, It_IT it it_IT.ISO88591,
it_IT.roman8

it_IT not supported

Portuguese (Brazilian) pt_BR, Pt_BR pt_BR pt_BR.ISO88591,
pt_BR.utf8

pt_BR not supported

Japanese Ja_JP, ja_JP ja_JP.PCK, ja ja_JP.SJIS,
ja_JP.eucJP

ja_JP Ja_JP.IBM-939,
Ja_JP.IBM-930

Simplified Chinese
(China)

Zh_CN, zh_CN zh, zh.GBK zh_CN.hp15CN zh_CN Zh_CN.IBM-
1388,
Zh_CN.IBM-935

Traditional Chinese
(Taiwan)

Zh_TW, zh_TW zh_TW,
zh_TW.BIG5

zh_TW.big5,
zh_TW.eucTW

zh_TW not supported

Korean ko_KR ko ko_KR.eucKR ko_KR not supported

Notes:

1. These values are the same for HP-Itanium and HP-UX on PA-RISC.
Because of limited syslog support on HP-UX operating systems,
messages are written to the log in US English only.

2. These values are the same for all Linux systems.

Other locales might be supported; check your operating system for further details.

System changes caused by installation and configuration
When you install WebSphere Message Broker, the installation program makes
certain changes to your computer.

Resources are also affected by how you configure your system (for example, the
brokers that you create).
v Start and main menu updates
v Directory structures
v Registry contents
v Environment variables
v Default WebSphere MQ resources
v Database contents

Start and main menu updates after installation
When you install WebSphere Message Broker components on Linux on x86 or
Windows, the installation program updates the main or Start menus.

Message Broker Toolkit on Linux on x86 running Red Hat

The main menu is populated with the following entries:
v Programming → IBM WebSphere Message Broker Toolkit

v Programming → IBM Installation Manager

If you install multiple products with Installation Manager on this operating
system, a single entry exists in the main menu and refers to the last
product that you installed. The package groups of installed products are
not reflected in the main menu. To invoke applications that you installed
previously, including other installations of the Message Broker Toolkit, you
must use the command line interface.
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If you want to start Installation Manager, for example to update or
uninstall one or more packages, you cannot use the main menu items,
because these actions require root authority. Become root and start the
Installation Manager program /eclipse/IBMIM in the Installation Manager
installation directory on the command line.

Message Broker Toolkit on Linux on x86 running SUSE

The main menu is populated with the following entries:
v All Applications → Development → IBM WebSphere Message Broker

Toolkit

v All Applications → Development → IBM Installation Manager

If you install multiple products with Installation Manager on this operating
system, a single entry exists in the main menu and refers to the last
product that you installed. The package groups of installed products are
not reflected in the main menu. To invoke applications that you installed
previously, including other installations of the Message Broker Toolkit, you
must use the command line interface.

If you want to start Installation Manager, for example to update or
uninstall one or more packages, you cannot use the main menu items,
because these actions require root authority. Become root and start the
Installation Manager program /eclipse/IBMIM in the Installation Manager
installation directory on the command line.

Message Broker Toolkit on Windows

The Start menu is populated with the following entries:
v IBM Software Development Platform → IBM WebSphere Message

Broker Toolkit → WebSphere Message Broker Toolkit

v IBM Software Development Platform → IBM WebSphere Message
Broker Toolkit → IBM Support Assistant

v IBM Software Development Platform → IBM WebSphere Message
Broker Toolkit → Release Notes

v IBM Software Development Platform → IBM WebSphere Message
Broker Toolkit → Start Toolkit Help

v IBM Software Development Platform → IBM WebSphere Message
Broker Toolkit → Stop Toolkit Help

These entries assume that you have installed into the first or default
package group. Additional products that you install in this package group
might also appear in this start list.

Entries are also added to the Start menu when Installation Manager is first
installed:
v Programs → IBM Installation Manager → IBM Installation Manager

v Programs → IBM Installation Manager → Release Notes

v Programs → IBM Installation Manager → Uninstall IBM Installation
Manager

v Programs → IBM Installation Manager → View Installed Packages

Runtime components on Windows

The Start menu is populated with the following entries:
v Programs → IBM WebSphere Message Brokers 6.1 → Command Console

v Programs → IBM WebSphere Message Brokers 6.1 → Java Programming
APIs → Configuration Manager Proxy API Documentation
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v Programs → IBM WebSphere Message Brokers 6.1 → Java Programming
APIs → Configuration Manager Proxy API Exerciser

v Programs → IBM WebSphere Message Brokers 6.1 → Java Programming
APIs → Java Plugin API Documentation

Directory structures after installation
When you install WebSphere Message Broker components, the installation program
creates a structure of subdirectories under the directory that you specified as the
installation directory. The exact structure depends on the platform on which you
have installed WebSphere Message Broker, and the components that you have
installed. If you install the Message Broker Toolkit, other directories might be
created for IBM Installation Manager, the Shared Resources Directory, and the
package group in which you install the toolkit.

AIX, HP-UX on PA-RISC Linux on x86-64, and Solaris on SPARC

On AIX, HP-UX on PA-RISC, Linux on x86-64, and Solaris on SPARC, the default
home directory install_dir is /opt/IBM/mqsi/6.1. The directories created in
install_dir are shown in the following table.

Directories under install_dir Contents

_uninst_runtime Uninstall programs

_uninst_runtime_jvm Uninstall programs (JVM)

adapters WebSphere Adapters files

bin Executable binaries

catalina Web Services support files

classes Java class files

DD64 ODBC driver and related files (64-bit support)

docs Java API files

exmltConfig XML transformation files

include Header and other files for samples

itlm Tivoli License Manager files

jplugin Java plug-in files

jre15 IBM Runtime Environment for the Java Platform Version 5
(also known as Version 1.5)

lib Shared library files

license License files

lil Loadable library files (64-bit)

lil32 Loadable library files (32-bit)

merant ODBC driver and related files

messages Description files for messages and exceptions

migration Migration files

ODBC32 Sample 32-bit ODBC configuration files

ODBC64 Sample 64-bit ODBC configuration files

readmes Product readme files

sample C, C++, and Java sample files

SecurityProviders Security files (64-bit)
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Directories under install_dir Contents

SecurityProviders32 Security files (32-bit)

webservices Web Services files

xlxpc Product library files

xml4c XML processing files

On AIX, HP-UX on PA-RISC, Linux on x86-64, and Solaris on SPARC, the working
directory is /var/mqsi/. The directories created are shown in the following table.

Directories under /var/mqsi Contents

common/errors Error files

common/locks Resource locks

common/log Trace files

common/profiles User profiles

components Component details

odbc ODBC files

registry Registry information

shared-classes User installed user-defined node classes

XML XML files

XSL XSL style sheets

HP-Itanium, Linux on POWER, Linux on System z, and Solaris on
x86-64

On HP-Itanium, Linux on POWER, Linux on System z, and Solaris on x86-64, the
default home directory install_dir is /opt/IBM/mqsi/6.1. The directories created in
install_dir are shown in the following table.

Directories under install_dir Contents

_uninst_runtime Uninstall programs

_uninst_runtime_jvm Uninstall programs (JVM)

adapters WebSphere Adapters files

bin Executable binaries

catalina Web Services support files

classes Java class files

DD64 ODBC driver and related files (64-bit support)

docs Java API files

exmltConfig XML transformation files

include Header and other files for samples

itlm Tivoli License Manager files

jplugin Java plug-in files

jre15 IBM Runtime Environment for the Java Platform Version 5
(also known as Version 1.5)

lib Shared library files
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Directories under install_dir Contents

license License files

lil Loadable library files

messages Description files for messages and exceptions

migration Migration files

ODBC64 Sample 64-bit ODBC configuration files

readmes Product readme files

sample C, C++, and Java sample files

SecurityProviders Security files

webservices Web Services files

xlxpc Product library files

xml4c XML processing files

On HP-Itanium, Linux on POWER, Linux on System z, and Solaris on x86-64, the
default working directory is /var/mqsi/. The directories created are shown in the
following table.

Directories under /var/mqsi Contents

common/errors Error files

common/locks Resource locks

common/log Trace files

common/profiles User profiles

components Component details

config Profiles

odbc ODBC files

registry Registry information

shared-classes User installed user-defined node classes

XML XML files

XSL XSL style sheets

Linux on x86

On this platform, you can install both the runtime components and the Message
Broker Toolkit.

Runtime components

On Linux on x86, the default home directory install_dir is /opt/ibm/mqsi/6.1. The
directories created in install_dir are shown in the following table.

Directories under install_dir Contents

_uninst_runtime Uninstall programs

_uninst_runtime_jvm Uninstall programs (JVM)

adapters WebSphere Adapters files

bin Executable binaries
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Directories under install_dir Contents

catalina Web Services support files

classes Java class files

docs Java API files

exmltConfig XML transformation files

include Header and other files for samples

itlm Tivoli License Manager files

jplugin Java plug-in files

jre15 IBM Runtime Environment for the Java Platform Version 5
(also known as Version 1.5)

lib Shared library files

license License files

lil Loadable library files

merant ODBC driver and related files

messages Description files for messages and exceptions

migration Migration files

ODBC32 Sample 32-bit ODBC configuration files

readmes Product readme files

sample C, C++, and Java sample files

SecurityProviders Security files

webservices Web Services files

xlxpc Product library files

xml4c XML processing files

The default working directory is /var/mqsi/. The directories created are shown in
the following table.

Directories under /var/mqsi Contents

common/errors Error files

common/locks Resource locks

common/log Trace files

common/profiles User profiles

components Component details

config Profiles

odbc ODBC files

registry Registry information

shared-classes User installed user-defined node classes

XML XML files

XSL XSL style sheets

Message Broker Toolkit

The default IBM Installation Manager installation directory is /opt/ibm/
InstallationManager. The default Shared Resources Directory is
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/opt/ibm/SDP70Shared. The default package group directory is /opt/IBM/WMBT610.
These directories are defined and described in the “Installation Guide” on page 3.

The directories created are shown in the following tables.

Directories under
/opt/ibm/InstallationManager Contents

eclipse Eclipse plug-in directories and files

license License files

Directories under
/opt/ibm/SDP70Shared Contents

atoc Eclipse plug-in directories and files

extra License files

features Product files for features installed on this computer

native

plugins Eclipse plug-in directories and files common to features
installed on this computer

Directories under
/opt/IBM/WMBT610 Contents

bin Directories and files for products within the package group

configuration Configuration files

eclipse Eclipse files

features Directories and files for products within the package group

jdk Java directories and files

lum License files

plugins Eclipse plug-ins and related files

ResourceAdapters Rational directories and files

runtimes Rational directories and files

samples Sample response files

uninstall Product uninstall files

wmbt Message Broker files

Other files are also stored by the Installation Manager in the directory
/var/ibm/InstallationManager.

Windows

On this platform, you can install both the runtime components and the Message
Broker Toolkit.

Runtime components

The default home directory install_dir is:
v On Windows 32-bit editions: C:\Program Files\IBM\MQSI\6.1.
v On Windows 64-bit editions: C:\Program Files(x86)\IBM\MQSI\6.1.
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The directories created in install_dir are shown in the following table.

Directories under install_dir Contents

_uninst_runtime Uninstall programs

_uninst_runtime_jvm Uninstall programs (JVM)

adapters WebSphere Adapters files

bin Executable binaries

catalina Web Services support files

classes Java class files

DataDirect ODBC driver and related files

docs Java API files

exmltConfig XML transformation files

include Header and other files for samples

itlm Tivoli License Manager files

jplugin Java plug-in files

jre15 IBM Runtime Environment for the Java Platform Version 5
(also known as Version 1.5)

lib Shared library files

license License files

messages Description files for messages and exceptions

migration Migration files

readmes Product readme files

sample C, C++, and Java sample files

webservices Web Services files

The default working directory is %ALLUSERSPROFILE%\Application Data\IBM\MQSI
where %ALLUSERSPROFILE% is the environment variable that defines the system
working directory. The default directory depends on the operating system:
v On Windows XP and Windows Server 2003: C:\Documents and Settings\All

Users\Application Data\IBM\MQSI

v On Windows Vista and Windows Server 2008: C:\ProgramData\IBM\MQSI

The actual value might be different on your computer.

The directories created are shown in the following table.

Directories under work_dir Contents

Common/dbinstmgr Derby database files on Windows XP and Windows Server
2003 (this directory is present but unused on Windows
Vista and Windows Server 2008)

Common/errors Error files

Common/locks Resource locks

Common/log Trace files

Common/profiles User profiles

components Component details

odbc ODBC files
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Directories under work_dir Contents

registry Registry information

shared-classes User installed user-defined node classes

XML XML files

XSL XSL style sheets

Message Broker Toolkit

On Windows 32–bit editions, the default IBM Installation Manager installation
directory is C:\Program Files\IBM\InstallationManager, the default Shared
Resources Directory is C:\Program Files\IBM\SDP70Shared, and the default package
group directory is C:\Program Files\IBM\IBM\WMBT610.

On Windows 64–bit editions, the default IBM Installation Manager installation
directory is C:\Program Files(x86)\IBM\InstallationManager, the default Shared
Resources Directory is C:\Program Files(x86)\IBM\SDP70Shared, and the default
package group directory is C:\Program Files(x86)\IBM\IBM\WMBT610.

These directories are defined and described in the “Installation Guide” on page 3.

The directories created are shown in the following tables.

Directories under
\IBM\InstallationManager Contents

eclipse Eclipse plug-in directories and files

license License files

Directories under
\SDP70Shared Contents

atoc Eclipse plug-in directories and files

extra License files

features Product files for features installed on this computer

native

plugins Eclipse plug-in directories and files common to features
installed on this computer

Directories under \WMBT610 Contents

bin Eclipse plug-in directories and files

configuration License files

features Product files for features installed on this computer

jdk Java directories and files

lum License files

plugins Eclipse plug-in directories and files common to features
installed on this computer

ResourceAdapters Rational directories and files

runtimes Rational directories and files

samples Sample response files
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Directories under \WMBT610 Contents

uninstall Product uninstall files

wmbt Message Broker files

Other files are also stored by the Installation Manager in the following directories:
v On Windows XP and Windows Server 2003: C:\Documents and Settings\All

Users\Application Data\IBM\Installation Manager and C:\Documents and
Settings\Administrator\IBM\InstallationManagerInstaller. Your computer
might have a different value for C:\Documents and Settings, but the remainder
of these paths are fixed.

v On Windows Vista and Windows Server 2008: C:\ProgramData\IBM\Installation
Manager and C:\ProgramData\IBM\InstallationManagerInstaller

z/OS

The default installation directory is /usr/lpp/mqsi/VxRxMx where VxRxMx
represents Version X, Release X, Modification X, for example, V6R1M0.

For more details of locations, libraries, and file system paths, see the Program
Directory for WebSphere Message Broker for z/OS or the Program Directory for
WebSphere Message Broker with Rules and Formatter for z/OS.

Registry changes created by installation and configuration
When you install WebSphere Message Broker, the installation program creates a
number of entries in a registry. Further changes are made by some configuration
updates (for example, when you create a broker).

Runtime components

On Windows, the system registry is used; on Linux and UNIX systems, equivalent
values are stored within the installation directory structure; the environment
variable $MQSI_REGISTRY is set to point to the location. Do not alter or remove
these entries unless instructed to do so by your IBM Service representative.

The table below describes the main Windows registry entries. These entries are
created under HKEY_LOCAL_MACHINE\SOFTWARE\IBM\WebSphereMQIntegrator (for
32–bit operating system editions) or HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\
IBM\WebSphereMQIntegrator (for 64–bit operating system editions).

Location Description

component_name Top level entry for each component that you have
installed and configured.

component_name\CurrentVersion\DataSourceName Name of database for this component.

component_name\CurrentVersion\FADLevel Formats and data version; contents depend on service
installed. FADLevel does not necessarily change with
each product update.

component_name\CurrentVersion\QueueManagerName Name of queue manager for this component.

Entries are also created under HKEY_LOCAL_MACHINE\SOFTWARE\ODBC\ODBCINST.INI
(for 32–bit operating system editions) or HKEY_LOCAL_MACHINE\SOFTWARE\
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Wow6432Node\ODBC\ODBCINST.INI (for 64–bit operating system editions); these
entries record the installed 32–bit database drivers for Oracle and Sybase, which
contain driver locations and parameters.

An entry is added under HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\
Services\Eventlog\Application\WebSphere Broker v*** for Event Log
information, where v*** is the current three-digit product version number.

Message Broker Toolkit

All registry entries are controlled by IBM Installation Manager. On Windows, the
system registry is used; on Linux on x86, equivalent entries are stored in
/var/ibm/InstallationManager/. Do not alter or remove these entries unless
instructed to do so by your IBM Service representative.

The installation directory for Installation Manager is stored in
HKEY_LOCAL_MACHINE\SOFTWARE\IBM\Installation Manager (for 32–bit operating
system editions) or HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\IBM\Installation
Manager (for 64–bit operating system editions), under the location value.

Uninstall keys are created for all products that are installed by Installation
Manager under HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\Current\
Version\Uninstall\IBM Installation Manager, under the name
IM-packagegroupname where packagegroupname is the name of the package group in
which the product is installed; for example, IBM Software Development Platform.

Environment variables after installation
On distributed systems, ensure that your environment is set up correctly.

If you have installed on z/OS, see Customizing the z/OS environment.

Sample profile files are provided with WebSphere Message Broker; check their
content to ensure the variables are set correctly for your environment before you
use the product or configure any resources.
v On Linux and UNIX systems, the profile is install_dir/bin/mqsiprofile.
v On Windows systems, a command console is set up when you install

components. Access this through the Start menu. When you select this option, a
command window containing the correct environment is opened.
If you prefer, run install_dir\bin\mqsiprofile.cmd in a command window
before working with WebSphere Message Broker in the same command window.

If you have more than one installation on a single system, ensure that you run the
correct profile, or access the correct command console, for the installation that you
want to work with. If an installation is at Version 5.0 or Version 6.0, the profile is
incompatible with the Version 6.1 profile. You must log off and log on again before
you run a second profile.

Check the readme file (readme.html) to ensure that you have the latest version of
the profile.

Default WebSphere MQ resources created during installation
and configuration

When you install WebSphere Message Broker and create components,
WebSphere MQ resources are created for use by those components.
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The names of these resources begin with the reserved characters SYSTEM. The
resources are additional to the default WebSphere MQ objects that are created
when you install that product. The following table lists the resources created, and
indicates the component queue manager with which they are associated.

Resource name Type Queue manager Description

SYSTEM.BROKER.ADMIN.QUEUE Queue Broker Target for messages
sent by the
Configuration
Manager and by
commands to
modify the
configuration and
operation of the
broker.

SYSTEM.BROKER.ADMIN.REPLY Queue Configuration
Manager

Target for response
messages that the
broker sends to the
Configuration
Manager.

SYSTEM.BROKER.AGGR.CONTROL Queue Broker Used internally to
store a control
message for each
aggregate group.

SYSTEM.BROKER.AGGR.REPLY Queue Broker Used internally to
store each known
response message
received by an
AggregateReply
node.

SYSTEM.BROKER.AGGR.REQUEST Queue Broker Used internally to
store each request
message that forms
part of an aggregate
group.

SYSTEM.BROKER.AGGR.TIMEOUT Queue Broker Used internally in
the timeout and
unknown timeout
processing within an
AggregateReply
node.

SYSTEM.BROKER.AGGR.UNKNOWN Queue Broker Stores each
unknown response
received by an
AggregateReply
node.

SYSTEM.BROKER.CONFIG.QUEUE Queue Configuration
Manager

Target for messages
that the toolkit sends
to the Configuration
Manager.

SYSTEM.BROKER.CONFIG.REPLY Queue Configuration
Manager

Target for messages
that the
Configuration
Manager sends to
the toolkit.

SYSTEM.BROKER.CONTROL.QUEUE Queue Broker Target for
publish/subscribe
control requests that
applications send to
the broker.
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Resource name Type Queue manager Description

SYSTEM.BROKER.EDA.COLLECTIONS Queue Broker Used internally to
store event handler
information for
message collections
generated by the
Collector node.

SYSTEM.BROKER.EDA.EVENTS Queue Broker Used internally to
store messages
received by the
Collector node.

SYSTEM.BROKER.EXECUTIONGROUP.QUEUE Queue Broker Target for messages
sent to execution
groups by internal
broker processes.

SYSTEM.BROKER.EXECUTIONGROUP.REPLY Queue Broker Target for response
messages sent by
execution groups to
internal broker
processes.

SYSTEM.BROKER.INTER.BROKER.COMMUNICATIONS Queue Broker Target for
publish/subscribe
control messages.

SYSTEM.BROKER.INTERBROKER.MODEL.QUEUE Queue Broker Model for dynamic
publication queues.

SYSTEM.BROKER.INTERBROKER.QUEUE Queue Broker Target for
publish/subscribe
messages sent by
neighbor brokers.

SYSTEM.BROKER.MODEL.QUEUE Queue All Model for dynamic
response queues.

SYSTEM.BROKER.SECURITY.QUEUE Queue User Name Server Target for messages
that the
Configuration
Manager, brokers,
and the workbench
send to the User
Name Server.

SYSTEM.BROKER.SECURITY.REPLY Queue Configuration
Manager and
brokers

Target for response
messages that the
User Name Server
sends to its
requestor.

SYSTEM.BROKER.TIMEOUT.QUEUE Queue Broker Used internally to
support the
TimeoutControl and
TimeoutNotification
nodes.

SYSTEM.BROKER.WS.ACK Queue Broker Used internally for
Web Services client
support.

SYSTEM.BROKER.WS.INPUT Queue Broker Used internally for
Web Services client
support.

SYSTEM.BROKER.WS.REPLY Queue Broker Used internally for
Web Services client
support.

SYSTEM.BKR.CONFIG SVRCONN Configuration
Manager

A connection
channel for
workbench clients.
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Appendix. Notices for WebSphere Message Broker

Read the legal notices for WebSphere Message Broker.

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this information
in other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this information. The furnishing of this information does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the information. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
information at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
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sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM United Kingdom Laboratories,
Mail Point 151,
Hursley Park,
Winchester,
Hampshire,
England
SO21 2JN

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this information and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Programming License Agreement, or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

This information includes examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
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IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

(C) (your company name) (year). Portions of this code are derived from IBM Corp.
Sample Programs. © Copyright IBM Corp. _enter the year or years_. All rights
reserved.

Trademarks in the WebSphere Message Broker Information Center
Review the trademark information for WebSphere Message Broker.

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at Copyright and
trademark information at www.ibm.com/legal/copytrade.shtml.

Adobe is a registered trademark of Adobe Systems Incorporated in the United
States, and/or other countries.

Intel, Itanium, and Pentium are trademarks of Intel Corporation in the United
States and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

Microsoft and Windows are trademarks of Microsoft Corporation in the United
States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the
United States, other countries, or both.

Other company, product, or service names may be trademarks or service marks of
others.
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